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Preface

TIBCO BusinessEvents® allows you to abstract and correlate meaningful business 
information from the events and data flowing through your information systems, 
and take appropriate actions using business rules. By detecting patterns within 
the real-time flow of events, TIBCO BusinessEvents can help you to detect and 
understand unusual activities as well as recognize trends, problems, and 
opportunities. TIBCO BusinessEvents publishes this business-critical information 
in real time to your critical enterprise systems or dashboards. With TIBCO 
BusinessEvents you can predict the needs of your customers, make faster 
decisions, and take faster action.

TIBCO BusinessEvents
The Power to Predict®

Topics

• Changes from the Previous Release of this Guide, page viii

• TIBCO BusinessEvents Express, page x

• Related Documentation, page xi

• Typographical Conventions, page xvi

• Connecting with TIBCO Resources, page xix

This software may be available on multiple operating systems. However, not 
all operating system platforms for a specific software version are released at the 
same time. Please see the readme.txt file for the availability of this software 
version on a specific operating system platform.
 TIBCO BusinessEvents Installation
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Changes from the Previous Release of this Guide

This section itemizes the major changes from the previous release of this guide. 

Supported Hardware and Software

Information about supported hardware and software is now located only in the 
product readme file. 

Migration Topics

The migration topics have been updated. 

• Information about migrating database concepts from 3.x to 5.x is now 
provided. 

• Information about migrating decision tables from 3.x to 5.x is now provided in 
this guide (and is removed from the TIBCO BusinessEvents Decision Manager 
User’s Guide. 

• Other general updates are made as required for migration to 5.1. 

See the following for details:

• Chapter 4, Migrating Projects from Earlier Versions, page 35

• Chapter 5, Property Migration Reference, page 67 

Eclipse P2 Provisioning

TIBCO BusinessEvents Studio is compatible with the Eclipse P2 provisioning 
system. The section Using an Existing Eclipse (or TIBCO Business Studio) 
Installation on page 19 has been updated with instructions to install the TIBCO 
BusinessEvents Studio repositories on an existing Eclipse installation. The list of 
required dependencies has also been updated.

Miscellaneous

• A short section explains a requirement for use of TIBCO Administrator. See If 
Deploying with TIBCO Administrator, Install it First on page 4

Other Changes

• The full version of TIBCO Hawk was required for the machine-level 
monitoring feature available in TIBCO BusinessEvents Monitoring and 
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Management. Now the limited version provided with TIBCO Runtime Agent 
is sufficient. The documentation has been updated accordingly.

However, the full version of TIBCO Hawk is required to use the Hawk 
channel.

• Instructions to enable the studio-tools utility on Solaris x86 have been 
added. See Configuring the Studio-tools Utility on Solaris x86 on page 23.

• Instructions to uninstall the software in console mode have been added. See 
Uninstall in Console Mode on page 17.

• The documentation now addresses the needs of partial installers as well as full 
installers.

• The chapter on installation FAQs and troubleshooting section has been 
removed because the content was no longer relevant for the current release.
 TIBCO BusinessEvents Installation
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TIBCO BusinessEvents Express

The TIBCO BusinessEvents Express edition provides more limited functionality 
than the TIBCO BusinessEvents Standard Edition. Some content in this 
documentation is not relevant to users of TIBCO BusinessEvents Express. Such 
content includes but is not limited to any chapters and major sections that contain 
a note indicating that the content does not apply to TIBCO BusinessEvents 
Express. 

Minor references to unsupported features may not be called out in the text. Use 
the following general guidelines to understand what is and is not supported in 
these cases:

• Only In Memory object management (OM) is supported. Therefore all 
functionality that requires Cache OM, such as use of a backing store, is not 
available. Berkeley DB OM is also not supported with the TIBCO 
BusinessEvents Express edition.

• Only the TIBCO BusinessEvents Decision Manager add-on is supported with 
the TIBCO BusinessEvents Express edition in this release. Other add-on 
products are not supported.
TIBCO BusinessEvents Installation
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Related Documentation

This section lists documentation resources you may find useful.

TIBCO BusinessEvents and Add-On Product Documentation
The following diagram shows the main documents in the TIBCO BusinessEvents 
documentation set, and the documentation sets for the optional add-on products.

Each set also contains an installation guide, release notes, and a readme file. 

TIBCO BusinessEvents Documentation

TIBCO BusinessEvents Studio, the design-time UI, is supported on Windows and 
Linux. The documentation set for TIBCO BusinessEvents is as follows.

TIBCO BusinessEvents® Standard Edition

Getting Started

AdministrationArchitect’s Guide

Developer’s 
Guide

Java API 
Reference

Functions 
Reference

Legend PDF HTML Eclipse help

TIBCO BusinessEvents® 
Data Modeling Add-On 
Documentation

TIBCO BusinessEvents® 
Event Stream Processing 
Add-On Documentation

TIBCO BusinessEvents® 
Decision Manager Add-On 
Documentation

TIBCO BusinessEvents® 
Views Add-On 
Documentation

TIBCO BusinessEvents® 
Process Orchestration
Add-On Documentation
 TIBCO BusinessEvents Installation
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• TIBCO BusinessEvents Installation: Read this manual for instructions on site 
preparation, installation, upgrading from an earlier release, and project 
migration.

• TIBCO BusinessEvents Getting Started: After the product is installed, use this 
manual to learn the basics of TIBCO BusinessEvents: project design, cache 
OM, and backing store. This guide explains the main ideas so you gain 
understanding as well as practical knowledge. 

• TIBCO BusinessEvents Architect’s Guide: If you are architecting an application 
using TIBCO BusinessEvents, read this guide for overview and detailed 
technical information to guide your work.

• TIBCO BusinessEvents Developer’s Guide: Use this guide when you implement a 
project design in TIBCO BusinessEvents Studio. It covers topics such as 
project-level tasks, resource-level tasks, debugging, and integration with 
TIBCO ActiveMatrix BusinessWorks. It also explains how to configure the 
CDD file for different object management options, and set up a backing store. 

• TIBCO BusinessEvents Administration: This book explains how to configure, 
deploy, monitor, and manage a TIBCO BusinessEvents application and the 
data it generates using TIBCO BusinessEvents Monitoring and Management 
component, TIBCO Administrator, or at the command line. It includes 
authentication and authorization topics.

• Online References:

— TIBCO BusinessEvents Java API Reference: This online reference is available 
from the HTML documentation interface. It provides the Javadoc-based 
documentation for the TIBCO BusinessEvents API.

— TIBCO BusinessEvents Functions Reference: This reference is available from 
the HTML documentation interface. It provides a listing of all functions 
provided with TIBCO BusinessEvents, showing the same details as the 
tooltips available in TIBCO BusinessEvents Studio.

• TIBCO BusinessEvents Release Notes: Read the release notes for a list of new and 
changed features. This document also contains lists of known issues and 
closed issues for this release.

TIBCO BusinessEvents Event Stream Processing

This TIBCO BusinessEvents add-on is available separately, and includes the 
TIBCO BusinessEvents Query Language features and the Pattern Matcher 
Service.

• TIBCO BusinessEvents Event Stream Processing Installation: Read this brief 
manual for installation instructions. A compatible version of TIBCO 
BusinessEvents must be installed before you install any add-on.
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• TIBCO BusinessEvents Event Stream Processing Query Developer’s Guide: This 
manual explains how to use the object query language to query various 
aspects of the running system For details on configuring and deploying query 
agents, see TIBCO BusinessEvents Developer’s Guide.

• TIBCO BusinessEvents Event Stream Processing Pattern Matcher  Developer’s 
Guide: This manual explains how to use the pattern matcher language and 
engine to correlate event patterns in a running system.

• TIBCO BusinessEvents Event Stream Processing Release Notes: Read the release 
notes for a list of new and changed features. This document also contains lists 
of known issues and closed issues for this release.

TIBCO BusinessEvents Decision Manager 

This TIBCO BusinessEvents add-on is available separately. It incorporates the 
Decision Manager decision modeling business user interface (supported on 
Windows and Linux), and the Rules Management Server (supported on all 
platforms supported by TIBCO BusinessEvents). 

• TIBCO BusinessEvents Decision Manager Installation: Read this brief manual for 
installation instructions. A compatible version of TIBCO BusinessEvents must 
be installed before you install any add-on.

• TIBCO BusinessEvents Decision Manager User’s Guide: This manual explains 
how business users can use decision tables and other decision artifacts to 
create business rules. It also covers configuration and administration of Rules 
Management Server, which is used for authentication, authorization, and 
approval processes.

• TIBCO BusinessEvents Decision Manager Release Notes: Read the release notes 
for a list of new and changed features. This document also contains lists of 
known issues and closed issues for this release.

TIBCO BusinessEvents Data Modeling

This TIBCO BusinessEvents add-on is available separately. It contains state 
models and database concept features.

• TIBCO BusinessEvents Data Modeling Installation: Read this brief manual for 
installation instructions. A compatible version of TIBCO BusinessEvents must 
be installed before you install any add-on.

• TIBCO BusinessEvents Data Modeling Developer’s Guide: This manual explains 
data modeling add-on features for TIBCO BusinessEvents. The database 
concepts feature enables you to model TIBCO BusinessEvents concepts on 
Database tables. The state modeler feature enables you to create state 
machines.
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• TIBCO BusinessEvents Data Modeling Release Notes: Read the release notes for a 
list of new and changed features. This document also contains lists of known 
issues and closed issues for this release.

TIBCO BusinessEvents Process Orchestration

This TIBCO BusinessEvents add-on is available separately. It provides CEP 
functionality within the context of a BPM process, enabling you segregate 
different CEP rule sets within the flow of a BPM process.

• TIBCO BusinessEvents Process Orchestration Installation: Read this manual for 
instructions on site preparation and installation. A compatible version of 
TIBCO BusinessEvents must be installed before you install any add-on.

• TIBCO BusinessEvents Process Orchestration Developer’s Guide: This guide 
explains how configure and deploy business processes whose actions are 
carried out using TIBCO BusinessEvents project resources.

• TIBCO BusinessEvents Process Orchestration Release Notes: Read the release 
notes for a list of new and changed features. This document also contains lists 
of known issues and closed issues for this release.

TIBCO BusinessEvents Views

This TIBCO BusinessEvents add-on is available separately. It includes graphical 
dashboard components for run-time event monitoring.

• TIBCO BusinessEvents Views Installation: Read this manual for instructions on 
site preparation and installation. A compatible version of TIBCO 
BusinessEvents must be installed before you install any add-on.

• TIBCO BusinessEvents Views Getting Started: After the product is installed, use 
this manual to learn how to use TIBCO BusinessEvents Views to create and 
run a dashboard using a step-by-step tutorial. 

• TIBCO BusinessEvents Views Developer’s Guide: This guide explains how to use 
TIBCO BusinessEvents Views to create meaningful metrics that are presented 
to business users in real-time for proactive decision making. 

• TIBCO BusinessEvents Views User’s Guide: This book explains how to monitor 
metrics in TIBCO BusinessEvents TIBCO BusinessEvents Views and how to 
represent the business processes graphically.

• TIBCO BusinessEvents Views Release Notes: Read the release notes for a list of 
new and changed features. This document also contains lists of known issues 
and closed issues for this release.
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Accessing TIBCO BusinessEvents Functions Reference Documentation
Reference documentation for functions, including those used in add-ons, is 
available in the HTML documentation interface for the TIBCO BusinessEvents 
documentation set, and as tooltips in TIBCO BusinessEvents Studio. To use the 
HTML-based functions reference from the file system do the following:

1. Browse to BE_HOME/doc/standard/html and click index.htm. The HTML 
documentation interface appears.

2. In the left panel, browse to Online References and in the right panel choose 
TIBCO BusinessEvents Functions Reference. The reference opens in a new tab.

3. Click the navigation links to browse to the functions as desired.

Other TIBCO Product Documentation
You may find it useful to refer to the documentation for the following TIBCO 
products:

• TIBCO ActiveSpaces®

• TIBCO Hawk®

• TIBCO Rendezvous®

• TIBCO Enterprise Message Service™

• TIBCO ActiveMatrix BusinessWorks™
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1   General Typographical Conventions

Convention Use

ENV_NAME

TIBCO_HOME 

BE_HOME 

TIBCO products are installed into an installation environment. A product 
installed into an installation environment does not access components in other 
installation environments. Incompatible products and multiple instances of the 
same product must be installed into different installation environments.

An installation environment consists of the following properties:

• Name Identifies the installation environment. This name is referenced in 
documentation as ENV_NAME. On Microsoft Windows, the name is 
appended to the name of Windows services created by the installer and is a 
component of the path to the product shortcut in the Windows Start > All 
Programs menu. 

• Path The folder into which the product is installed. This folder is referenced 
in documentation as TIBCO_HOME. 

TIBCO BusinessEvents installs into a directory within a TIBCO_HOME. This 
directory is referenced in documentation as BE_HOME. The default value of 
BE_HOME depends on the operating system. For example on Windows systems, 
the default value is C:\tibco\be\5.1.

code font Code font identifies commands, code examples, filenames, pathnames, and 
output displayed in a command window. For example:

Use MyCommand to start the foo process.

bold code 

font 
Bold code font is used in the following ways:

• In procedures, to indicate what a user types. For example: Type admin. 

• In large code samples, to indicate the parts of the sample that are of 
particular interest.

• In command syntax, to indicate the default parameter for a command. For 
example, if no parameter is specified, MyCommand is enabled: 
MyCommand [enable | disable]
TIBCO BusinessEvents Installation



Preface | xvii
italic font Italic font is used in the following ways: 

• To indicate a document title. For example: See TIBCO 
ActiveMatrixBusinessWorks Concepts.

• To introduce new terms For example: A portal page may contain several 
portlets. Portlets are mini-applications that run in a portal.

• To indicate a variable in a command or code syntax that you must replace. 
For example: MyCommand PathName

Key 
combinations

Key name separated by a plus sign indicate keys pressed simultaneously. For 
example: Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the 
other. For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for 
example, an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply 
the information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, 
data loss or corruption if certain steps are taken or not taken.

Table 1   General Typographical Conventions (Cont’d)

Convention Use

Table 2   Syntax Typographical Conventions

Convention Use

[ ] An optional item in a command or code syntax.

For example: 

MyCommand [optional_parameter] required_parameter

| A logical OR that separates multiple items of which only one may be chosen.

For example, you can select only one of the following parameters: 

MyCommand param1 | param2 | param3
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{ } A logical group of items in a command. Other syntax notations may appear 
within each logical group.

For example, the following command requires two parameters, which can be 
either the pair param1 and param2, or the pair param3 and param4.

MyCommand {param1 param2} | {param3 param4}

In the next example, the command requires two parameters. The first parameter 
can be either param1 or param2 and the second can be either param3 or param4:

MyCommand {param1 | param2} {param3 | param4}

In the next example, the command can accept either two or three parameters. 
The first parameter must be param1. You can optionally include param2 as the 
second parameter. And the last parameter is either param3 or param4.

MyCommand param1 [param2] {param3 | param4}

Table 2   Syntax Typographical Conventions

Convention Use
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Connecting with TIBCO Resources

This section provides links to helpful TIBCO resources.

How to Join TIBCOmmunity
TIBCOmmunity is an online destination for TIBCO customers, partners, and 
resident experts, a place to share and access the collective experience of the 
TIBCO community. TIBCOmmunity offers forums, blogs, and access to a variety 
of resources. To register, go to http://www.tibcommunity.com.

How to Access TIBCO Documentation
You can access TIBCO documentation here: 

http://docs.tibco.com

How to Contact TIBCO Support
For comments or problems with this manual or the software it addresses, contact 
TIBCO Support as follows:

• For an overview of TIBCO Support, and information about getting started 
with TIBCO Support, visit this site:

http://www.tibco.com/services/support

• If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user 
name, you can request one.
 TIBCO BusinessEvents Installation
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Chapter 1 Installation Guidelines

This chapter provides information to ensure a successful installation of the TIBCO 
BusinessEvents software. 

Topics

• TIBCO BusinessEvents Components and Add-on Products, page 2

• Installation Overview, page 4

• Upgrading TIBCO BusinessEvents, page 8

TIBCO BusinessEvents Express This guide is also used to document installation 
of the TIBCO BusinessEvents Expresss edition. The TIBCO BusinessEvents 
Express edition supports only In Memory object management. Content that 
requires cache functionality does not apply to TIBCO BusinessEvents Express 
edition.
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TIBCO BusinessEvents Components and Add-on Products

This section lists the product components and add-on products.

TIBCO BusinessEvents Standard Edition Components
TIBCO BusinessEvents Standard Edition provides the following components.

• TIBCO BusinessEvents Studio Eclipse-based component for designing TIBCO 
BusinessEvents projects.

• TIBCO BusinessEvents DataGrid Used for cache functionality. Cannot be 
separately installed or uninstalled.

• Monitoring and Management A configurable web-based user interface for 
monitoring and managing TIBCO BusinessEvents clusters.

• Eclipse Platform A provided Eclipse platform. If you do not use the provided 
Eclipse installation, you must have a preexisting Eclipse installation, at the 
supported release level. See Using an Existing Eclipse (or TIBCO Business 
Studio) Installation on page 19 for more information.

• Documentation TIBCO BusinessEvents documentation. The doc folder 
contains an HTML and a PDF folder. If you do not install documentation, this 
folder is not included in the installation. 

• Runtime The runtime engine. Cannot be separately installed or uninstalled.

• Rules Management Server (RMS) A lightweight server component for 
managing the repository of projects. It also includes the client component, 
WebStudio, which is a web-based user interface that allows business users to 
create and manage business rules in a web browser.

TIBCO BusinessEvents Express Edition Components
TIBCO BusinessEvents Express edition provides the following components.

• TIBCO BusinessEvents Studio Eclipse-based component for designing TIBCO 
BusinessEvents projects.

• Monitoring and Management A configurable web-based user interface for 
monitoring and managing TIBCO BusinessEvents clusters.

• Eclipse Platform A provided Eclipse platform. If you do not use the provided 
Eclipse installation, you must have a preexisting Eclipse installation of a 
supported version. See Using an Existing Eclipse (or TIBCO Business Studio) 
Installation on page 19 for more information.
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• Documentation TIBCO BusinessEvents documentation. The doc folder 
contains an HTML and a PDF folder. If you do not install documentation, this 
folder is not included in the installation. 

• Runtime The runtime engine. Cannot be separately installed or uninstalled.

Add-on Products
When you install TIBCO BusinessEvents Standard Edition, you can also install 
any add-on products you have purchased. Add-ons available in this release are 
shown below.

• TIBCO BusinessEvents Data Modeling

• TIBCO BusinessEvents Event Stream Processing

• TIBCO BusinessEvents Decision Manager

• TIBCO BusinessEvents Process Orchestration

• TIBCO BusinessEvents Views

Install all add-ons (except TIBCO BusinessEvents Process Orchestration) that are 
at the same version as TIBCO BusinessEvents. Do not install add-ons before you 
have installed TIBCO BusinessEvents. (You can, however, install TIBCO 
BusinessEvents and add-ons at the same time, as explained in the installation 
instructions.)

For TIBCO BusinessEvents Express edition, only TIBCO BusinessEvents Decision 
Manager is supported.
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Installation Overview

If Deploying with TIBCO Administrator, Install it First
If TIBCO Administrator is used to deploy TIBCO BusinessEvents applications, 
you must install TIBCO Runtime Agent and TIBCO Administrator (on machines 
where you will deploy TIBCO BusinessEvents applications) before you install 
TIBCO BusinessEvents.

If TIBCO BusinessEvents is the first TIBCO product installed, it will not be found 
by TIBCO Administrator.

This requirement does not apply on machines where TIBCO BusinessEvents will 
be used for design-time activities only.

Using Oracle Coherence as Alternative Cache Provider
Only TIBCO BusinessEvents DataGrid is provided with TIBCO BusinessEvents. 
Alternatively, you can use a supported version of Oracle Coherence, for which 
you must have a license that is appropriate for your usage. 

Using OpenSSH for TIBCO BusinessEvents Monitoring and Management
TIBCO BusinessEvents Monitoring and Management (MM) is a provided 
component. It is one of the options available for deployment, monitoring, and 
management. (If TIBCO Administrator is used in your environment, you can use 
it instead.)

The version of TIBCO BusinessEvents and all add-on products except 
TIBCO BusinessEvents Process Orchestration must match.

Add-ons, all except TIBCO BusinessEvents Process Orchestration, must be at the 
same version as TIBCO BusinessEvents in order to work correctly. When you 
upgrade TIBCO BusinessEvents, you must also upgrade the add-on products in 
use to the same version. Similarly, you cannot install a later version of an add-on 
onto an earlier version of TIBCO BusinessEvents. 
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OpenSSH is one of the options available to enable MM to perform remote start 
and deployment of TIBCO BusinessEvents engines running on Microsoft 
Windows. See the product readme for supported versions of the third party 
software.

Required and Optional Products and Supported Platforms
For details about supported platforms, related TIBCO software, and third party 
products, see the product readme file in the TIBCO_HOME/release_notes 
directory.

Installation History Log Files
Installation and uninstallation history is kept in log files in the .TIBCO directory 
within the installer’s user (or home) directory. 

The folder names use this format:

install_month-day-year.time

uninstall_month-day-year.time

The installation log files record environment details such as the user that invoked 
the installer, hostname, operating system details, and so on.

TIBCO Home and Default Installation Directory
The installer prompts you to specify the TIBCO home (TIBCO_HOME) where you 
want to install TIBCO BusinessEvents. Each TIBCO home is a separate 
environment. You can install the same software into different environments safely, 
for example, for test, QA, and staging purposes. You can install multiple TIBCO 
products into the same environment or into different ones. See Using Multiple 
TIBCO Homes on page 6.

A TIBCO home has a name and a directory on disk. The directory is the root 
directory for all TIBCO products you want to install into this TIBCO home. 

Copssh is another option that can be used. Note that only versions 3.1.3 and 3.1.4 
are supported.

When installing multiple TIBCO products into a single TIBCO Home, ensure that 
all the products are compatible. 
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Microsoft Windows

The default installation location is the TIBCO_HOME where all TIBCO products are 
installed. Typically, TIBCO_HOME is c:\tibco.

The Start menu path to the executable files includes the environment as follows:

Start > TIBCO > TIBCO_HOME > TIBCO BusinessEvents 5.1

The name is also appended to the name of Windows services created by the 
installer. 

UNIX

The default installation directory depends on who performs the installation:

• For root users, the default installation directory is /opt/tibco.

• For non-root users, the default installation directory is /<myhome>/tibco, 
where <myhome> is the home directory of the user.

Using Multiple TIBCO Homes
It is possible that certain versions of TIBCO software products installed on your 
computers may not work well together. You may also want to install multiple 
versions of the same product on the same machine, for example if you are testing 
the current release while using the prior release in production. To avoid any 
issues, one solution is to install each product in its own TIBCO home, under a 
common parent directory, for example called tibco. In the following example, 
be_40, be_50, bw_59 and administrator_57 are all separate TIBCO homes: 

tibco/
be_40/

be
be_50/

be
bw_59/

bw
administrator_57/

administrator
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Using an Existing Eclipse (or TIBCO Business Studio™) Installation
Using the bundled Eclipse software is recommended. However, you can 
optionally use an existing Eclipse installation. You can, for example, use the 
Eclipse installation provided with TIBCO Business Studio business modeling 
software. This option is not available with partial installers (commonly used for 
service pack releases). 

Limiting Access to
TIBCO

BusinessEvents
Installations

Here is another case for using an existing Eclipse installation. In some enterprises, 
users are given limited access to software, such as TIBCO BusinessEvents. All 
users, however, require full rights to the Eclipse installation because certain files 
are written during normal use of BusinessEvents Studio. In this case you must 
install Eclipse separately, in areas where users have permission to write. 

See Using an Existing Eclipse (or TIBCO Business Studio) Installation on page 19.
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Upgrading TIBCO BusinessEvents

Standard Upgrade Procedures
Software from TIBCO uses three numbers to indicate whether the release is major, 
minor or a patch. For example, 5.0.0 indicates a major release, 5.4.0 indicates a 
minor release and 5.3.3 indicates a service pack release. 

The installer for a service pack release performs an automatic upgrade. For 
example, the installer would automatically upgrade TIBCO BusinessEvents 5.3.0 
to 5.3.1 by overwriting the contents of the 5.3 directory. 

If you are upgrading TIBCO BusinessEvents to a new major or minor version, it is 
strongly recommended that you uninstall the earlier version of the product first 
and perform a fresh installation (full product installers only). 

Installing Over the Same Version

Note that if you are reinstalling over the same version, if any files are currently 
locked (that is, in use), the installer marks the file for deletion in the install 
location. After installation if the installer prompts you to reboot your system, you 
must reboot before using the software.

Before You Upgrade Read Chapter 4, Migrating Projects from Earlier Versions, on 
page 35.
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Chapter 2 TIBCO BusinessEvents Installation

This chapter describes how to install this release using TIBCO Universal Installer.

Topics

• Installation Guidelines, page 10

• Installing TIBCO BusinessEvents, page 12

• Verifying the Installation, page 16

• Uninstalling TIBCO BusinessEvents, page 17

• Using an Existing Eclipse (or TIBCO Business Studio) Installation, page 19

• Configuring the Studio-tools Utility on Solaris x86, page 23

• Enabling the Generate Deployable Feature on Solaris, page 25
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Installation Guidelines

The sections below provide guidelines for installing on Windows and UNIX 
platforms.

Windows Installation Guidelines
All 32-bit installers are supported on 64-bit platforms as 32-bit software.

Installer Account

You must have administrator privileges for the machine on which the software is 
installed.

If you do not have administrator privileges, the installer exits. You must then log 
out of the system and log in as a user with the required privileges, or request your 
system administrator to assign the privileges to your account. 

Installing from a Network Drive 

If you intend to install the product from a network drive, you must ensure that 
the account used for installation has permission to access the network drive.

Installing on Windows 2000 Terminal Server

There are two modes in terminal server, Execute and Install. By default all 
users are logged on in Execute mode, which allows them to run the applications. 
When you want to install the software for use by everyone, the Administrator 
should change to Install mode.

The best way to install the software on Windows 2000 Terminal Server is to use 
the Add/Remove Programs control panel applet, because this automatically sets 
the mode to Install during the installation and then back to Execute at the end.

Alternatively, you can manually change your mode to Install by typing C:\> 
change user /install 

Change back to execute by typing C:\> change user /execute 

Check your current mode by typing C:\> change user /query 

If deploying with TIBCO Administrator  Install it on machines where you will 
deploy TIBCO BusinessEvents applications before you install TIBCO 
BusinessEvents. See If Deploying with TIBCO Administrator, Install it First on 
page 4.
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If you install in the Execute mode, the installation registry is maintained in your 
user home directory. If you install in the Install mode, the installation registry is 
maintained in the %SystemRoot% folder.

UNIX Installation Guidelines

Installer Account

The software can be installed by a regular (non-root) user and super-user (root). 
Different users can install the same product at different locations

Permissions

The user performing the installation must have Read Write Execute permissions 
on all files and directories, after the file is unpacked. The file structure after 
unpacking must be identical to the structure that was packed.

Windowing Environment

A windowing environment such as CDE (that is, X11 Windows) is required to run 
the installer in GUI mode. It is not required for a console installation or silent 
installation. 

Installation of TIBCO BusinessEvents add-on products must be performed by the 
same user who installed TIBCO BusinessEvents Dependency checking will not 
work correctly unless the same user installs all dependent products.

For platforms that support 64-bit mode, post installation configuration is 
required. See Configuration for 64-bit Mode on page 32.

For HP-UX platforms, also see HP-UX on page 33.
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Installing TIBCO BusinessEvents

Install in GUI Mode
The following procedure explains how to install the software in GUI mode.

1. Prepare to install as follows:

a. Log in to the system on which you want to install TIBCO BusinessEvents.

b. Extract the TIBCO BusinessEvents product archive file to a temporary 
directory then navigate to that directory. You can also extract the product 
archive files for all TIBCO BusinessEvents add-on products that you are 
installing to the same temporary directory. See the Tip section above,

2. Run the TIBCO Universal Installer executable (TIBCOUniversalInstaller*).

3. Review the information in the Welcome dialog. If you are installing multiple 
add-ons, they are listed in this dialog. Click Next.

4. The License Agreement dialog displays. Review the terms of the license 
agreement and, if you agree to them, click I accept the terms of the license 
agreement. Then click Next to continue with the installation. If you are also 
installing add-on products, you must accept each license separately.

(If you do not agree to the terms of the license agreement, click Cancel to exit 
from the installation process.)

If using an existing Eclipse installation See Using an Existing Eclipse (or TIBCO 
Business Studio) Installation on page 19 for steps you may want to take before 
installing TIBCO BusinessEvents.

After installation is complete Perform any post-installation tasks as required. See 
Chapter 3, Post Installation Tasks, on page 27.

Installing Multiple TIBCO BusinessEvents Products at One Time You can install 
multiple products at one time by extracting the product archive files to the same 
temporary directory. For example, you can install TIBCO BusinessEvents and one 
or more add-ons together. Or if you have already installed TIBCO 
BusinessEvents, you can install multiple add-ons together. 

Multiple Install Does Not Work in Silent Mode Note that this technique works in the 
GUI and Console modes but not in Silent mode. In Silent mode, the silent 
installation file is overwritten with the last product that you extract, and installs 
only the last extracted product.
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5. Select or create a TIBCO home. For more details and guidelines see TIBCO 
Home and Default Installation Directory on page 5. Do one of the following:

— Select Use an Existing TIBCO_HOME and select a home from the list.

For a service pack, select the TIBCO home used by the prior release.

— Create a new TIBCO home. Browse to and select a directory, and provide a 
name for the home. 

The name cannot contain special characters such as "*", "?", ">", "<", ":", "|", 
"/", "\", or quotes ("). 

Click Next.

6. For full installers only, you can customize the installation as follows. 

(If you don’t want to customize the installation just click Next without 
checking the Customize Installation checkbox and go to step 5.)

a. Check the Customize Installation check box. 

b. Optionally select only the components you want to install. See TIBCO 
BusinessEvents Standard Edition Components on page 2 for guidelines.

c. Click Next. 

d. A dialog appears where you can specify the location of a different Eclipse 
installation from the version provided with TIBCO BusinessEvents. Do 
one of the following.

— Do not check the Use my own Eclipse installation check box. Just click Next 
to accept the provided Eclipse installation. (This is the recommended 
approach). 

— Check the Use my own Eclipse installation check box. Specify the location 
of your Eclipse installation in the Eclipse Installation Location field, and 
click Next. Also see Using an Existing Eclipse (or TIBCO Business Studio) 
Installation on page 19 for additional configuration required to use your 
own installation. 

7. The installer performs some basic checks and if it finds any problems with the 
Eclipse configuration that you specified, it displays messages. If you are 
installing TIBCO BusinessEvents before your own copy of Eclipse, you can 
ignore the messages and continue the installation.

8. The installer configures your installation choices, then the Pre-Install 
Summary dialog displays. Review the information in the dialog and make 
sure that it is correct.

If you want to change any of your choices, click Back to step back through the 
dialogs to the appropriate point. You can then restart the installation process 
from that point.
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If you are satisfied with your choices, click Install.

The installer now performs the necessary installation tasks. 

9. You may be prompted to replace files already on disk that are newer than the 
installation files. 

— In the case of a fresh installation of the add-on over a prior fresh installation 
of a full installer version of the add-on or of TIBCO BusinessEvents, such 
messages are harmless: overwrite all existing files.

— In the case of files you have changed: if you want to save settings in any 
existing files, first save a backup of the files to a different name, and then 
replace the original files with the newly installed files. After installation 
configure the newly installed files using information from the prior 
version’s file backups, as needed. 

10. When installation has completed, the Post Install Summary dialog displays. 
Click Finish to exit from the installer. There is a slight delay while the installer 
deletes temporary files.

Install in Console Mode
The following procedure explains how to install the software in console mode.

1. Open the physical media or download the TIBCO BusinessEvents product 
package.

2. Extract the TIBCO BusinessEvents product archive file to a temporary 
directory.

3. Using a console window, navigate to the temporary directory that contains the 
universal installer and run the installer using this command line: 
TIBCOUniversalInstaller -console

4. Complete the installation by responding to the console window prompts, 
which are similar to those described in the GUI mode instructions.

Install in Silent Mode
The following procedure explains how to install the software in silent mode. Any 
errors that occur during installation are listed in the installation log file (see the 
User_Home/.TIBCO directory.
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Configure the Installation Responses

A configuration file, 
TIBCOUniversalInstaller_productAcronym_relVersion.silent, is provided with 
the universal installer. Copy the file to another name (but keep the .silent 
extension) and use it to configure your installation choices. 

You must edit the file in a text editor and provide all non-default values as needed 
before launching the silent installation. For example, ensure that the 
installationRoot and createNewEnvironment attributes are set correctly. The 
file includes comments to help you set the installation properties.

Save the configuration file to the same directory where the universal installer file 
is located. It is recommended that you back up the original file or save your 
edited file to a different name. This file is known as the response file.

Install in Silent Mode

1. Extract the TIBCO BusinessEvents product archive file to a temporary 
directory.

2. Using a console window, navigate to the temporary directory that contains the 
universal installer.

3. To run the installer execute the following command, replacing myfile with your 
response file name:

TIBCOUniversalInstaller -silent -V responseFile="myfile.silent"

You can rename the 
TIBCOUniversalInstaller_productAcronym_relVersion.silent file to 
TIBCOUniversalInstaller.silent and run the command without 
specifying the .silent file name as:

TIBCOUniversalInstaller -silent

A line similar to the following is written to the installer log file when 
installation completes:
The installation has completed. Please check the log file for 
additional information.

Ensure that the installationRoot and createNewEnvironment specified in the 
configuration file do not exist already.
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Verifying the Installation

TIBCO BusinessEvents and TIBCO BusinessEvents add-on product installations 
can be verified as follows.

Verifying TIBCO BusinessEvents Installation
After installation of TIBCO BusinessEvents and any of its add-on products, verify 
the installation as follows.

To verify if the installation is successful, first check the file 
tibco_universal_installer.userid_install.log, which is located in the 
.TIBCO directory of the user performing the installation:

Errors in this file, or the existence of error files under this folder, indicates 
installation problems. Error files have the following format:

antTask_ERROR_log_post-install_mm-dd-yyy.n.log

If the log files do not indicate any errors, then open a simple example project in 
TIBCO BusinessEvents Studio, and also run the example at the command line. 
The example readme files explain how to run the examples at the command line, 
from the installed location. Check for errors on the command line or user 
interface. Absence of errors, and a normal engine start up indicate successful 
installation.

Verifying Add-On Product Installations
To verify that add-ons are installed, look for the list of add-ons in the folder 
TIBCO_HOME/_installInfo. Every successfully installed add-on has a 
corresponding XML file under this folder. 

You can also check the install log file to confirm which add-ons are installed.
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Uninstalling TIBCO BusinessEvents

Uninstall in GUI mode
To uninstall TIBCO BusinessEvents in the GUI mode, do the following:

1. Do one of the following to start the uninstaller:

— Navigate to the TIBCO_HOME/tools/universal_installer directory 
and run the TIBCOUniversalInstaller program. 

— (Windows) From the Start menu, select Start > All Programs > TIBCO > 
TIBCO_HOME > Uninstall.

— (Windows) Use Add/Remove Programs from the Control Panel.

2. The Welcome screen appears. Click Next.

3. Do one of the following:

— To uninstall only a selection of products in this TIBCO home, click Custom 
Uninstall. Select the product or products you want to uninstall. Then click 
Next. See TIBCO BusinessEvents Standard Edition Components on page 2 
for guidelines.

— To uninstall all TIBCO products in this TIBCO home (that were installed 
using the universal installer), click Typical Uninstall. Then click Next.

4. The Pre-Uninstall Summary screen appears. Click Uninstall. Uninstallation 
proceeds and then you see the Post-Uninstall Summary. 

5. Click Finish to close the uninstaller window.

6. If you are prompted to do so, restart the computer. 

You may also want to manually delete any remaining files in the installation 
directory to completely remove the product.

For information on the uninstallation log files, see Installation History Log Files 
on page 5.

Uninstall in Console Mode
To uninstall TIBCO BusinessEvents in the console mode, do the following:

Service Pack Releases In the case of a service pack release, this procedure 
uninstalls the entire TIBCO BusinessEvents installation, not just the service pack. 
It is not possible to uninstall only the service pack.
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1. Open a console window and navigate to the directory:

TIBCO_HOME/tools/universal_installer

2. Run the TIBCOUniversalInstaller in console mode using the command:
TIBCOUniversalInstaller -console

3. Respond to the prompts on the console window to uninstall the software.
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Using an Existing Eclipse (or TIBCO Business Studio) Installation

This section is optional, for those using an existing eclipse installation instead of 
one provided with TIBCO BusinessEvents.

TIBCO BusinessEvents Studio is compatible with the Eclipse P2 provisioning 
system. You can choose to install TIBCO BusinessEvents Studio on an existing 
Eclipse installation using one of the following approaches:

• Executing the script install_studio_repo available at 
BE_HOME/studio/repo. See Install Using the Script install_studio_repo on 
page 20 for details.

• Using Ant to run the build file available at BE_HOME/studio/repo. See 
Install Using Ant on page 21 for details.

• Copying the links and updating the .ini files manually. This is applicable 
only when installing on an existing basic Eclipse installation and not on 
TIBCO Business Studio. See Install Manually by Copying Links and Updating 
.ini Files on page 22 for details.

Eclipse Requirements and Installation Guidelines 

TIBCO recommends using the Eclipse software bundled with the TIBCO 
BusinessEvents software. However, if you prefer to use your existing Eclipse 
software installation, or want to install Eclipse separately, or want to install 
TIBCO BusinessEvents for use with the TIBCO Business Studio business 
modeling software product, you must update the existing Eclipse installation 
with the required plug-ins. You can do this before or after installing TIBCO 
BusinessEvents.

The Eclipse requirements are:

• Eclipse release 3.7.2

• Eclipse Delta Pack 3.7.2

• Eclipse Modeling Framework (EMF) release 2.7.2

• Eclipse Graphical Editing Framework (GEF) release 3.7.2

• Eclipse Process Framework (EPF) Richtext Feature release 1.5.1.4

• Model Development Tools (MDT) UML release 3.2.1

Using an existing Eclipse (or TIBCO Business Studio) installation is possible only 
for releases with full installers. It is not possible for releases with partial installers, 
such as service pack releases.
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• Eclipse Web Tools Platform (WTP) release 3.3.2

Perform the following tasks to ensure that the dependencies required by Eclipse 
and TIBCO BusinessEvents are installed and available:

1. Download the files listed in Eclipse Requirements and Installation Guidelines, 
page 19 from the Eclipse Foundation web site. 

This step is optional if the script install_studio_repo is used as described 
in Install Using the Script install_studio_repo, page 20.

2. If you have not already done so, install the Eclipse release.

3. Extract the other components (Delta Pack, EMF, GEF, MDT, and WTP) to the 
top-level directory of your Eclipse installation. 

4. Install TIBCO BusinessEvents (and one or more add-on products if required) 
as explained in Installing TIBCO BusinessEvents on page 12. Remember to 
select the Use my own Eclipse installation check box.

5. Choose one of the following approaches to install TIBCO BusinessEvents 
Studio:

— Install Using the Script install_studio_repo, page 20

— Install Using Ant, page 21

— Install Manually by Copying Links and Updating .ini Files, page 22

Install Using the Script install_studio_repo

This option is available only if the Eclipse Platform feature is installed when 
installing TIBCO BusinessEvents. If the Eclipse Platform feature is not installed, 
you can use Ant to install TIBCO BusinessEvents Studio as described in Install 
Using Ant on page 21.

When you install TIBCO BusinessEvents (and one or more add-ons), the TIBCO 
BusinessEvents Studio repositories are installed under BE_HOME/studio/repo. 
For each of the installed products, a folder with the product name is created 
under BE_HOME/studio/repo.

Scripts are provided with the repositories to install on an existing Eclipse 
installation. Using a console window, navigate to BE_HOME/studio/repo and 
run the following command (on Windows):

install_studio_repo.bat <absolutePathOf_YourEclipse>/eclipse.exe

The script performs the following tasks:

The TIBCO BusinessEvents products can be installed before installing the Eclipse 
software. Ensure that all of them are installed before proceeding to the next step.
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• installs the TIBCO BusinessEvents Studio repositories for all the installed 
products.

• checks if the dependencies are available. If they are not available, the script 
downloads the dependencies from the Eclipse download site.

• Updates the following properties in Your_Eclipse/eclipse.ini file:

-DBE_HOME=path to BE_HOME

-Dstudio.wrapper.tra.file=<path to 
BE_HOME>/studio/eclipse/configuration/studio.tra

-DJDK_LIB=TIBCO_JAVA_HOME/lib

The script throws an error with an appropriate message if the Eclipse executable 
or the eclipse.ini files are missing.

Once the execution is completed, start Eclipse and open the BusinessEvents 
Perspective to access the TIBCO BusinessEvents Studio features.

Install Using Ant 

This option does not require the Eclipse Platform feature to be installed when 
installing TIBCO BusinessEvents. Ensure that Ant is installed and available in 
your environment.

Install TIBCO BusinessEvents Studio on an existing Eclipse installation by 
executing the command:

ant -buildfile install_studio_repo.xml 
-DappBinary=<absolutePathOf_YourEclipse>/eclipse.exe 
-DappIni=<absolutePathOf_YourEclipse>/eclipse.ini

The script performs the tasks described in Install Using the Script 
install_studio_repo, page 20. Once the execution is completed, start Eclipse and 
open the BusinessEvents Perspective to access the TIBCO BusinessEvents Studio 
features.

If the dependencies are not available, you must ensure that the machine has 
network connectivity to enable to script to download the required files. This may 
take a while to complete.

The script uses JRE 1.6 that is provided with TIBCO BusinessEvents. To use a 
different JDK, edit the property DJDK_LIB and specify the absolute path of the 
JDK that is to be used.
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Install Manually by Copying Links and Updating .ini Files

This approach can be used to install on any existing standard Eclipse installation 
only.

1. Copy the files TIBCOBusinessEvents-Studio-plugins.link and 
TIBCOBusinessEvents-EclipsePlatform-plugins.link from 
BE_HOME/studio/eclipse/dropins_configuration to Your_Eclipse/links.

2. Configure the Your_Eclipse/eclipse.ini file as follows:

— Ensure that the VM setting is done for Java 1.6 JVM. Path should appear in 
a new line:

–vm 

path to JRE 1.6

— Add the following properties to -vmargs, each on a new line
-DBE_HOME=path to BE_HOME

-Dstudio.wrapper.tra.file=<path to 
BE_HOME>/studio/eclipse/configuration/studio.tra

-DJDK_LIB=path to JRE 1.6/lib

3. Change directory to the Your_Eclipse location and run the command:
eclipse -clean –initialize

4. Run the command eclipse. 

Running this command loads Eclipse with the BusinessEvents Studio 
plug-ins.

This approach does not support installing TIBCO BusinessEvents Studio on 
TIBCO Business Studio.
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Configuring the Studio-tools Utility on Solaris x86

This section is optional and provides information on how to enable studio-tools 
on Solaris x86.

1. Install TIBCO BusinessEvents (and one or more add-on products, as required) 
on the Solaris x86 machine as explained in Installing TIBCO BusinessEvents 
on page 12.

2. Download and install Eclipse 3.7.2 for Solaris Sparc available on the Eclipse 
download site. 
(http://archive.eclipse.org/eclipse/downloads/drops/R-3.7-201106131736/
download.php?dropFile=eclipse-SDK-3.7-solaris-gtk-x86.zip)

3. Copy the following files from a Linux installation to the corresponding 
location in the Solaris installation:

— TIBCO BusinessEvents Studio plugins available under 
BE_HOME/studio/plugins

— BE_HOME/studio/bin/studio-tools.tra

You must have access to a Linux installation as the TIBCO BusinessEvents Studio 
plugins required to enable the studio-tools utility are shipped with the Linux 
installer.
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4. On Solaris installation location, create the folder 
BE_HOME/eclipse-platform/eclipse/ and copy the following from the 
respective locations on the Linux installation:

— BE_HOME/eclipse-platform/eclipse/dropins/TIBCOBusinessEvents
-Studio-plugins.link

— BE_HOME/eclipse-platform/eclipse/dropins/eclipse/plugins/*em
f*

— BE_HOME/eclipse-platform/eclipse/dropins/eclipse/plugins/*um
l*

— BE_HOME/eclipse-platform/eclipse/dropins/eclipse/plugins/jav
ax.xml_1.3.4.*.jar

— BE_HOME/eclipse-platform/eclipse/plugins/org.apache.commons.
codec_1.3.0.*.jar

— BE_HOME/eclipse-platform/eclipse/plugins/org.apache.commons.h
ttpclient_3.1.0.*.jar

— BE_HOME/eclipse-platform/eclipse/dropins/eclipse/plugins/org
.apache.xerces_2.9.0.*.jar

— BE_HOME/eclipse-platform/eclipse/dropins/eclipse/plugins/org
.apache.xml.resolver_1.2.0.*.jar

— BE_HOME/eclipse-platform/eclipse/dropins/plugins/org.apache.
xml.serializer_2.7.1.*.jar

5. Edit the file studio-tools.tra and specify the appropriate environment 
paths for the variables TIB_HOME, BE_HOME, TIB_JAVA_HOME, and 
JVM_LIB_PATH.

6. Edit the file TIBCOBusinessEvents-Studio-plugins.link and specify the 
location of the TIBCO BusinessEvents Studio plugins. 

7. Copy the wrapper executable from TIBCO_HOME/tools/wrapper/wrap (or 
wrap64) to BE_HOME/studio/bin/studio-tools.

8. Change directory to BE_HOME/eclipse-platform/eclipse and run the 
command: 

eclipse -clean -initialize
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Enabling the Generate Deployable Feature on Solaris

IThe Generate Deployable menu option does not work when Rules Management 
Server is running on HPUX, AIX, and Solaris except the Solaris SPARC 32-bit 
platform. For Solaris SPARC 32-bit the following configuration changes are 
required: 

1. Following the detailed instructions in the section Using an Existing Eclipse (or 
TIBCO Business Studio) Installation on page 19, download and install the 
Eclipse packages for Solaris platform.

2. Import and install the TIBCO BusinessEvents Studio plug-ins from a Linux 
installation of TIBCO BusinessEvents. TIBCO BusinessEvents Studio plug-ins 
are located under BE_HOME/studio/eclipse/plugins.

3. In the BE_HOME/rms/bin/be-rms.tra file, add the following to the classpath 
using the tibco.env.STD_EXT_CP setting:

BE_HOME/eclipse-platform/eclipse/plugins

BE_HOME/studio/eclipse/plugins
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Chapter 3 Post Installation Tasks

This chapter explains some post-installation steps you may have to perform in 
your installation.

Topics

• Post Installation Tasks for All Platforms, page 28

• Check and Update JVM Settings in Properties Files, page 29

• All UNIX Installations — Directory Permissions, page 31

• Configuration for 64-bit Mode, page 32

Also see Chapter 4, Migrating Projects from Earlier Versions, on page 35 for 
additional procedures you may have to do after installation. 
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Post Installation Tasks for All Platforms

This section explains changes that are required in the circumstances shown.

Also see Check and Update JVM Settings in Properties Files on page 29 in case it 
pertains to your situation.

Migrating Projects
For all projects created using prior releases, you must perform migration steps. 
After you migrate, you must also rebuild the EAR files for the projects, as is 
always the case when you upgrade. See Chapter 4, Migrating Projects from 
Earlier Versions, on page 35 and carefully follow all instructions.

Re-Initialize Studio Plug-ins Registry after Add-on Software Installation
When you install add-on products after installing TIBCO BusinessEvents, you 
need to ensure that the correct plug-ins contributed by the add-ons are initialized. 
To do this, re-initialize the studio plug-ins registry before you start using TIBCO 
BusinessEvents Studio, as explained next. 

To Re-Initialize Studio Plug-ins

1. Open a command prompt

2. Change directory to BE_HOME/studio/eclipse.

3. Run the command
studio -clean -initialize
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Check and Update JVM Settings in Properties Files

Check the engine properties file to ensure that all settings are appropriate for your 
platform. 

Set the Heap Size as Needed

By default, the initial (–Xms) and maximum (–Xmx) heap size are set to 1GB for 
both TIBCO BusinessEvents and TIBCO BusinessEvents Decision Manager. 
Change the settings as needed to meet your requirements. For TIBCO 
BusinessEvents, the settings are in the BE_HOME/bin/be-engine.tra file. For 
TIBCO BusinessEvents Decision Manager they are in the 
BE_HOME/decisionmanager/eclipse/DecisionManager.ini file.

For example, if you want to run both TIBCO BusinessEvents Decision Manager 
and TIBCO BusinessEvents on a machine with 1GB memory, you might reduce 
the initial heap size setting (–Xms):

java.extended.properties=-server –Xms512m -Xmx1024m 

As another example, if you use a machine with more memory, and you work with 
very large tables in TIBCO BusinessEvents Decision Manager, you might increase 
the TIBCO BusinessEvents Decision Manager heap size accordingly. 

It can also be helpful to set the MaxPermSize as follows:

-XX:MaxPermSize=128m

Platform-Specific Settings

Some of the JVM settings do not work for all platforms, and some platforms use 
additional, platform-specific parameters. For example:

For 64 bit Sun JVM for Intel or AMD on Linux, use 

JVM_LIB_PATH=%TIB_JAVA_HOME%/lib/amd64/server/libjvm.so

For 64 bit Sun JVM for Intel or AMD on Windows, use:

JVM_LIB_PATH=%TIB_JAVA_HOME%/lib/amd64/server/libjvm.dll

For AMD on Windows and 32 bit Sun JVM for Intel use:

JVM_LIB_PATH=%TIB_JAVA_HOME%/lib/i386/server/libjvm.dll

The IBM AIX platform uses parameters common to all JVMs, but does not use the 
-d64 parameter. AIX also uses additional parameters (using the format, 
-Xparameter). 

This task is required for full installations. It is not typically required for service 
pack installations. It is valid on all platforms.
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Refer to the appropriate JVM reference manuals for the platform in question. For 
example, for AIX you could refer to the following resources. 

http://www.ibm.com/developerworks/java/jdk/aix/j564/sdkguide.aix64.html

http://www.ibm.com/developerworks/java/jdk/aix/j532/sdkguide.aix32.html

Note that on AIX, you can determine the mode in which JVM is running using the 
following simple Java program:

System.getProperty("com.ibm.vm.bitmode");

It returns the following values:

* 32 - the JVM is running in 32-bit mode
* 64 - the JVM is running in 64-bit mode
TIBCO BusinessEvents Installation
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All UNIX Installations — Directory Permissions

This section explains what directory permissions must be set to enable users to 
use the system.

Permissions for TIBCO BusinessEvents Directories
All TIBCO BusinessEvents users must have read, write, and execute permissions 
for the following directories:

bin Directory
$TIBCO_HOME/be/5.1/bin

For example, if TIBCO BusinessEvents has been installed in /opt/tibco, the user 
who installed TIBCO BusinessEvents should execute the following commands:

% chmod 777 /opt/tibco/be/5.1/bin/

(Other changes can be made using the chown command as needed.)

You can verify ownership and permissions using the long listing command, ls 
-l.

• This task is required for full installations. It is not typically required for service 
pack installations.

• This step is required on all UNIX platforms.

• If you use TIBCO BusinessEvents Decision Manager, refer to its installation 
guide for additional actions.
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Configuration for 64-bit Mode

The following platforms allow you to run TIBCO BusinessEvents in 64-bit mode. 
See the product readme for versions supported:

• AIX

• HP-UX Itanium 

• HP PA-RISC

• Linux

• Solaris 10 SPARC

• Solaris 10 X86

To Configure for 64-bit Mode

1. Open all TRA files for editing. Do this for TIBCO BusinessEvents and for each 
add-on product used:

BE_HOME/bin/be-engine.tra
BE_HOME/bin/be-jdbcdeploy.tra
BE_HOME/bin/be-migration.tra
BE_HOME/mm/bin/be-mm.tra
BE_HOME/rms/bin/be-rms.tra 
BE_HOME/views/bin/be-views.tra

(be-rms.tra is used with TIBCO BusinessEvents Decision Manager and 
be-views.tra is used with TIBCO BusinessEvents Views.)

An additional step is required for the HP-UX platforms. See HP-UX on page 33).

For Microsoft Windows, a 64-bit installer is available from the download site.
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2. In each TRA file do the following:

a. In the tibco.env.STD_EXT_CP property, find %RV_HOME%/lib and replace 
it with %RV_HOME%/lib/tibrvj.jar.

b. Ensure that the JVM_LIB_PATH variable points to the appropriate JVM 
Server DLL or SO. For example:

For 64 bit Sun JVM for AMD on Linux, use:
JVM_LIB_PATH = %TIB_JAVA_HOME%/lib/amd64/server/libjvm.so

For 64 bit Sun JVM for AMD on Windows, use:
JVM_LIB_PATH =%TIB_JAVA_HOME%/bin/amd64/server/libjvm.dll

c. To increase the heap size used by the engine, modify the values of –Xms 
and –Xmx in the java.extended.properties parameter. For example, 
some common values are as follows:

-d64 -XX:MinHeapFreeRatio=52  -XX:MaxHeapFreeRatio=90 -XX:GCTimeRatio=19 

-Xms1024m -Xmx1024m -javaagent:%BE_HOME%/lib/cep-base.jar -XX:MaxPermSize=256m 
-XX:+UseParNewGC -XX:+UseConcMarkSweepGC

The TRA files are self-documented with guidelines.

HP-UX
If you are using an HP-UX platform, open the be-engine.tra file and remove the 
following entry from the property java.extended.properties property:

-javaagent:%BE_HOME%/lib/cep-instrumentation.jar

(If this property is present, the executable fails to launch.)

Enabling 64-bit Properties

By default, the 32-bit java.extended.properties are enabled. 

Comment the 32-bit java.extended.properties and enable the 64-bit 
java.extended.properties in the TRA files in these folders:

BE_HOME/bin/be-engine.tra 

BE_HOME/mm/bin/be-mm.tra

BE_HOME/rms/bin/be-rms.tra
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Chapter 4 Migrating Projects from Earlier Versions

Also see Chapter 3, Post Installation Tasks, on page 27 for non-project related 
actions required for various situations.

Read this chapter carefully and follow all migration steps that apply to your case.

Topics

• Project Migration Overview, page 36

• For Berkeley DB Object Management Users Only, page 38

• Migration from 5.0 to 5.1, page 39

• Migration from 4.x to 5.1, page 40

• Migrating 4.x Projects, page 43

• Migrating 3.x Projects, page 50

• Enabling Use of Oracle Coherence as the Cache Provider, page 55

• Understanding the CDD File (For 3.x Users), page 56

• Importing a 3.x TIBCO Designer Project, page 58

• Clean and Validate 3.x Projects, page 61

• Oracle Types to JDBC Backing Store Migration, page 63
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Project Migration Overview

This chapter includes migration of add-on products, so that all migration 
information is available in one place.

Many of the actions you must take to migrate projects to the current release 
depend on the version you are migrating from, and the features you use. Some 
manual steps are required. More manual steps are required for earlier versions 
than for 4.x projects due to the changes in architecture.

Read the rest of this section and then check the section for the release from which 
you are migrating:

• If you are upgrading from 5.0 to 5.1, the CDD model needs to be refreshed. See 
Migration from 5.0 to 5.1 on page 39 for details.

• If you are upgrading from 4.0, first upgrade to 4.0.1 and then migrate to 5.1. 
See Migrating 4.x Projects on page 43, and referenced sections.

• If you are upgrading from 3.x, you can migrate directly to 5.0 and then to 5.1. 
Follow the manual steps as required. See Migrating 3.x Projects on page 50, 
and referenced sections.

• If you are upgrading from a version earlier than 3.0, first upgrade to the latest 
3.x version, following directions in the 3.x documentation.

Check Release Notes
In all cases, check all sections in the Release Notes and take action accordingly. 
Release notes for all products in the same TIBCO home are located in the 
TIBCO_HOME/release_notes directory.

No migration steps are required for JDBC backing store implementations or data. 
JDBC backing store was first made available in 3.0.1 Hotfix 6.
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Migrating from Coherence to TIBCO BusinessEvents DataGrid Cache Provider
TIBCO DataGrid cache provider feature replaces Coherence as the built-in cache 
provider in version 5.0.0. A set of core Coherence functions has been renamed 
(and additional internal changes have been made) so that these functions can be 
used with either the Coherence or the TIBCO BusinessEvents DataGrid cache 
provider. The renamed functions are in the Standard catalog Cluster.DataGrid 
category. See Table 3, Mapping of Coherence Functions to TIBCO BusinessEvents 
DataGrid Functions, on page 42 for details. 

A TIBCO BusinessEvents Studio refactoring operation, and a TIBCO 
BusinessEvents Studio Tools command line option are available to do the function 
migration for specific purposes other than general migration. See Migrating Core 
Coherence Functions for the TIBCO BusinessEvents Studio option and see 
Migrating Core Coherence Functions at the Command Line for the command-line 
option, both in TIBCO BusinessEvents Developer’s Guide.

Fixing Errors Due to Use of Words in Reserved Word List
As TIBCO BusinessEvents develops, the number of reserved words increases. For 
the current list of reserved words, check Chapter 19, Rule Language Grammar > 
Keywords and Other Reserved Words, in TIBCO BusinessEvents Developer’s Guide. 

Validation shows errors for use of keywords as identifiers: 

Reserved keyword, cannot be used as an identifier

To Resolve the Issue If you use any of the listed words as identifiers, resource 
names, or folder names, change them in your 5.1 project.

Not all Coherence functions are available for use with TIBCO BusinessEvents 
DataGrid When you migrate to the current release with TIBCO BusinessEvents 
DataGrid as the cache provider, certain Coherence functions are not migrated. In 
particular, the functions in the following categories are not migrated: 
Standard/Coherence/Constants, Standard/Coherence/Extractors, 
Standard/Coherence/Filters, Standard/Coherence/Query 

If you are concerned that your projects may require some recoding, contact your 
TIBCO representative for more details.
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For Berkeley DB Object Management Users Only

Berkeley DB OM, formerly called Persistence OM, is an older form of data 
persistence. Support for this option is removed in version 5.1. 

You can migrate to Cache OM with backing store. 

There is no direct migration path from the Berkeley DB OM database to a JDBC 
backing store. Migration is a two stage procedure:

1. As needed, upgrade using the latest 3.x or 4.x version of TIBCO 
BusinessEvents. Those versions have a utility to migrate the data to the legacy 
backing store schema, the Oracle Types backing store schema. 

2. Migrate from the Berkeley DB database to the legacy Oracle Types backing 
store. To complete this step, follow instructions in the TIBCO BusinessEvents 
Installation guide for the version you are using for this step of the migration. 

3. Migrate from the Oracle Types backing store to the JDBC backing store, 
following instructions in Oracle Types to JDBC Backing Store Migration on 
page 63.

4. Migrate the project to 5.1. 

— If you are using the latest 5.x version, see Migration from 5.0 to 5.1 on 
page 39.

— If you are using the latest 4.x version, see Migrating 4.x Projects on page 43.

— If you are using the latest 3.x version, see Migrating 3.x Projects on page 50.
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Migration from 5.0 to 5.1

This section provides information about the manual tasks that need to be 
performed when migrating from 5.0 to 5.1. See Migration from 4.x to 5.1 on 
page 40 if you are migration older projects to 5.1.

Changes to the CDD File

Import your project into a 5.1 workspace and edit the CDD file to remove the 
newly added element <enabled>false</enabled> from under the backing store 
entries for the cluster tab.

Migration from 5.0 to 5.1 for Add-on Products
In addition to migration content for TIBCO BusinessEvents, migration of add-on 
products is documented in this chapter for your convenience.

TIBCO BusinessEvents Views

Automatic Changes

Migrates About This Chart text The About this Chart property has been removed 
from charts. When projects from the prior release are migrated to the current 
release, the text from those properties is appended to the chart description.

Manual Changes

Changes to Logo Image and Branding Image Handling The method of including 
branding images has been improved. Images are now stored in the TIBCO 
BusinessEvents Studio project. To migrate to the new method do the following.

1. Open the project in TIBCO BusinessEvents Studio, and select File > Import > 
File System. Use the Eclipse dialog to locate the image file or files you want to 
use, and import them into a project folder. /Dashboards/Images is the 
recommended location.

Edit the Login and Header resources. In the ImageURL field, browse to the project 
folder where the imported graphic is located and select it.

Entries related to the load balancer and process-groups can remain as is.
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Migration from 4.x to 5.1

All changes listed in the section Migration from 5.0 to 5.1 on page 39 need to be 
performed in addition to the changes described below.

Manual Change

When migrating 4.x projects, edit the CDD file and set the cluster level property 
be.engine.cluster.as.discover.url with a valid value (for example, 
tibpgm://9995/) preferably inside a property group "tibas".

Automatic Changes

The migration utility automatically does the following:

Migrates core Coherence functions to product neutral ones A set of core Coherence 
functions has been renamed so that these functions can be used with either the 
Coherence or the TIBCO BusinessEvents DataGrid cache provider. Not all 
Coherence functions are migrated. See Migrating from Coherence to TIBCO 
BusinessEvents DataGrid Cache Provider on page 37 for important information.

Migrates the channel driver type Driver type is migrated from the 4.0 format to the 
current format.

Migrates HTTP channel settings HTTP channel tuning settings are now 
maintained in the channel resource instead of the processing unit (PU) area of the 
CDD. During the migration process, you specify the CDD and within it the PU 
whose settings you want to migrate. Settings from the selected PU are applied to 
all HTTP channels.

Migrates CDD file namespaces Namespace is changed to the following: 
http://tibco.com/businessevents/configuration/5.0.

Migrates entity metadata properties to CDD domain object override settings In 
earlier versions, entity-specific configuration for cache and backing store was 
done using metadata properties (also known as extended properties). It is now 
done in the CDD only. The migration utility moves all relevant metadata property 
settings to the equivalent settings in the CDD Domain Objects Overrides area. An 
override is added for each entity type. You can later remove unnecessary entries 
as needed. (There is no change to configuration for metadata properties used by 
the TIBCO BusinessEvents Data Modeling add-on product.) 

No migration steps are required for JDBC backing store implementation or data
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Migrates localStorage Property to isSeeder property (partial migration) The 
property tangosol.coherence.distributed.localstorage is migrated to the 
cache-provider-neutral property be.engine.cluster.isSeeder. However, a 
change in design makes this property redundant. Cache storage is now set at the 
processing unit level, using a checkbox labeled Enable Cache Storage. It is not 
possible to set this checkbox at migration time. Note that without further action, if 
the isSeeder property is set higher in the order of precedence than the processing 
unit, then the isSeeder property is used at runtime. However, if the isSeeder 
property is set lower in the order of precedence than the processing unit, then the 
checkbox value is used. To complete migration, remove the isSeeder property 
and instead use the processing unit setting Enable Cache Storage in the project 
CDD file. Note that enabling cache storage on non-cache agents is not 
recommended for production. It can be useful for testing and demonstration 
purposes.

Site Topology, TIBCO BusinessEvents Version Field The value of the TIBCO 
BusinessEvents Version field in Cluster Settings and in Host Settings is updated to 
the current version.

Adds CDD properties for TIBCO BusinessEvents Monitoring and Management 
authentication, which is a new feature in 5.0. The properties are added in these 
locations:

• BE_HOME/mm/project/emonitor > MM.cdd > mm-class agent class > 
properties > mm/auth property group

• ToBeMonitored_Project > project.cdd > Cluster properties > auth property group.

The properties are added to all project CDDs if a project has more than one. The 
following properties are added, with the default values as shown:

be.mm.auth.type=file
be.mm.auth.file.location=BE_HOME/mm/config/users.pwd
java.security.auth.login.config=BE_HOME/mm/config/jaas-config.con

Add-on Product
Migration

Migrates TIBCO BusinessEvents Views default skin TIBCO BusinessEvents Views 
has a new look-and-feel. The default skin is migrated automatically. If you use 
this add-on product, you can view the default skin settings using the view-only 
System Elements resource. See TIBCO BusinessEvents Views Developer’s Guide for 
details about how you can use the System Elements when you define your own 
color schemes and skins.
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Migrates TIBCO BusinessEvents Decision Manager metadata location Metadata 
information for decision tables was being stored in the (internal) .beproject file. 
Now it is stored in the decision table file itself.

Table 3   Mapping of Coherence Functions to TIBCO BusinessEvents DataGrid Functions

4.x Coherence Category Function Name DataGrid Category Function Name 

C_CacheGetEntityById() CacheGetEntityById()

C_CacheLoadConceptByExtId() CacheLoadConceptByExtId()

C_CacheLoadConceptById() CacheLoadConceptById()

C_CacheLoadConceptIndexedByExtId() CacheLoadConceptIndexedByExtId()

C_CacheLoadConceptsByExtId() CacheLoadConceptsByExtId()

C_CacheLoadEntity() CacheLoadEntity()

C_CacheLoadEventByExtId() CacheLoadEventByExtId()

C_CacheLoadEventById() CacheLoadEventById()

C_CacheLoadParent() CacheLoadParent()

C_CacheName() CacheName()

C_CacheReevaluate() CacheReevaluate()

C_ClassName() ClassName()

C_EnableCacheUpdate() EnableCacheUpdate()

C_Index() Index() 

C_Lock() Lock() 

C_TransactionProperties TransactionProperties()

C_UnLock() UnLock()
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Migrating 4.x Projects

This section outlines how to migrate 4.x projects, after you install TIBCO 
BusinessEvents 5.1 (as explained in Chapter 1 through Chapter 3 of this guide).

Task A Upgrade 4.0.0 Projects to 4.0.1

If you are running 4.0.0, first upgrade to 4.0.1. Open the 4.0.0 projects in TIBCO 
BusinessEvents Studio and save them.

Task B Import Projects in TIBCO BusinessEvents Studio

A command line utility to do the same actions is also provided. After importing 
using the command line utility an additional procedure is required before you can 
work with the project in TIBCO BusinessEvents Studio. See Importing a TIBCO 
BusinessEvents 4.x Project at the Command Line on page 46.

For details about what is migrated, see Migration from 4.x to 5.1 on page 40.

1. After installing TIBCO BusinessEvents 5.1, start TIBCO BusinessEvents Studio 
using a different workspace from the workspace containing the 4.x projects.

2. Select File > Import > Existing TIBCO BusinessEvents Studio 4.0 Project and 
click Next.

3. Browse to and select the project root directory of the 4.x project you are 
migrating.

4. Do one of the following:

— Check the Copy project into workspace checkbox. This option copies the 
project into your current workspace. 

— Uncheck the Copy project into workspace checkbox and specify an import 
location. 

5. Do one of the following:

— If your project has no HTTP channels, click Finish (this is the only option). 

— If your project has one or more HTTP channels, click Next.

Berkeley DB object management is removed from the product in version 5.1. If 
you are migrating from Berkeley DB, see For Berkeley DB Object Management 
Users Only on page 38 for preliminary steps to take in order to change to Cache 
OM. 
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6. If you clicked Next you see the Select Processing Unit dialog. Select the project 
CDD, and within it, the processing unit that contains the HTTP properties to 
be migrated. 

An informational panel displays the settings that will be migrated.

Task C TIBCO BusinessEvents Views CDD Change

If you use the TIBCO BusinessEvents Views add-on product, you may need to 
update the CDD for changes to the following dashboard agent properties:

All CDD files in the project are touched by the migration (see Migration from 4.x 
to 5.1 on page 40 for details). However, only the CDD file specified here is used 
for HTTP channel property migration.

4.x Property 5.0 Property

be.http.docRoot be.agent.dashboard.http.docroot

The default is BE_HOME/views/web-root
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Because the replacement properties now have default values, you only have to 
add the properties if you need to set a non-default value. 

Do the following depending on your use case:

• If you have not changed the provided 4.x property values, and do not need to 
use a non-default value in 5.1, remove the 4.x properties from the CDD.

• If you changed the value for one or both of the above properties, rename the 
property or properties to the 5.1 name (as shown above). Do this in the 
dashboard agent properties area of the CDD, for all affected dashboard agents 
(or at a higher level as appropriate to the scope you want to use).

Task D Choose a Cache Provider and Configure Settings (Cache OM only)

Beginning with TIBCO BusinessEvents 5.0.0, Oracle Coherence is no longer 
provided with TIBCO BusinessEvents. An internal component, TIBCO 
BusinessEvents DataGrid, is used by default. See Migrating from Coherence to 
TIBCO BusinessEvents DataGrid Cache Provider on page 37 for important 
information about migration of Coherence functions. If you use cache OM, action 
is required:

• If you want to switch from Oracle Coherence to TIBCO BusinessEvents 
DataGrid, you must manually reconfigure the CDD file settings. See 
Chapter 24, Cache OM and Cluster Configuration in TIBCO BusinessEvents 
Developer’s Guide for details. 

• If you want to continue using Oracle Coherence as the cache provider, you 
must acquire a licensed copy of Oracle Coherence software and do some 
configuration. See Enabling Use of Oracle Coherence as the Cache Provider on 
page 55 for details.

• The property tangosol.coherence.distributed.localstorage is 
migrated automatically to the cache-provider-neutral property 
be.engine.cluster.isSeeder. However, a change in design makes this 
property redundant. Cache storage is now set at the processing unit level, 
using a checkbox labeled Enable Cache Storage. It is not possible to set this 
checkbox at migration time. To complete migration, remove the isSeeder 
property and instead configure cache storage for non-cache agents as needed 
use the processing unit setting Enable Cache Storage in the project CDD file. 
Note that enabling cache storage on non-cache agents is not recommended for 
production. It can be useful for testing and demonstration purposes.

be.http.docPage be.agent.dashboard.http.docpage

The default value is index.html

4.x Property 5.0 Property
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Task E Migrate Legacy Oracle-only Backing Stores to JDBC Backing Store 

The legacy Oracle-only (Oracle Types) backing store is no longer supported. If 
you were using the legacy Oracle-only (Oracle Types) backing store, you must 
migrate to the current implementation. See Oracle Types to JDBC Backing Store 
Migration, page 63.

Task F (All Cases) Validate the Project in TIBCO BusinessEvents Studio

It is recommended that you validate the project in TIBCO BusinessEvents Studio 
after migration, to help ensure that the project is correctly configured. 

Certain validation checks were added after 4.0. So validating the project may 
reveal issues that were not caught in the earlier release from which you migrated.

Task G Rebuild EAR Files

As with any upgrade, you must rebuild all EAR files created with an earlier 
version. 

Importing a TIBCO BusinessEvents 4.x Project at the Command Line
This option is equivalent to the following menu option in TIBCO BusinessEvents 
Studio: File > Import > TIBCO BusinessEvents > Existing TIBCO BusinessEvents 
4.0 Project, explained in Task B, Import Projects in TIBCO BusinessEvents Studio, 
on page 43. 

After you complete the procedures in this section, complete the migration tasks as 
shown following Task B, as needed for your project.

When you use this command-line (or TIBCO BusinessEvents Studio) option to 
import 4.x TIBCO BusinessEvents Studio projects, the same migration actions are 
done as in the UI-based migration. See Migration from 4.x to 5.1 on page 40

Before you can use a 4.x project imported at the command-line in TIBCO 
BusinessEvents Studio you must do another procedure, explained in To Open a 
Project Imported at the Command Line in TIBCO BusinessEvents Studio on 
page 48. 

To Import an Existing 4.x Project at the Command Line

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.

2. Execute a command with the following format (all on one line) at a command 
prompt:
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studio-tools -op importExistingProject [-h] -p studioProjDir [-o targetProjDir] [-c 
CDDprojectPath] [-u PUNameFromCDD]

For example:

studio-tools -op importExistingProject -p C:\FT\SomeProj -o c:\MyWorkspace\SomeProj 
-c COM.cdd -u Invproc

If HTTP channel properties are migrated (from a specified CDD and processing 
unit to all HTTP channel resources’ Advanced tab) you see a message like this: 

Migrating HTTP properties of Processing Unit "PUName" from CDD "CDDprojectPath" to 
HTTPChannel(s) present in the project

When the import has completed successfully, you see a message in the command 
window like the following:

The existing 4.0 TIBCO BusinessEvents project has been successfully imported to 
c:\MyWorkspace\SomeProj.

Table 4, TIBCO BusinessEvents Studio Tools Options for Importing an Existing 
Project, provides detailed information about the options. 

Table 4   TIBCO BusinessEvents Studio Tools Options for Importing an Existing Project

Option Description

-op 
importExistingProject

Specifies the importExistingProject operation for importing a 
TIBCO BusinessEvents Studio project into the workspace.

-h Optional. Displays help.

-p Source project: absolute path to the project directory of the TIBCO 
BusinessEvents Studio project to be imported.
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To Open a Project Imported at the Command Line in TIBCO BusinessEvents 
Studio

To open a project imported at the command line, you must add it as a new project.

1. Start TIBCO BusinessEvents Studio. In Windows, click Start > All Programs > 
TIBCO > YourEnvironment > TIBCO BusinessEvents 5.1 > TIBCO 
BusinessEvents Studio.

2. From the File menu select New > Project. You see the New Project — Select a 
Wizard dialog. 

3. Select TIBCO BusinessEvents > Studio Project and click Next.

4. In the Project Name field, enter the directory name where the imported project 
is located. (This is used as the project name.)

-o Optional. Absolute path to the target project directory, where the 
project is imported to. 

If you specify the source project directory name as the last element in 
the path, it is used as the target project directory. If you specify a 
different directory as the last element in the path, the directory is 
created if it does not exist, and the source project directory is 
imported within the specified target directory.

If you do not specify a target project directory, the original project 
contents are updated. If the project to be imported is a TIBCO 
BusinessEvents version 4 project, it is no longer compatible with 
version 4 after the import. 

If the target location points to an existing project, the import does not 
proceed and this message displays: 

The specified target location already exists and cannot 
be used.

-c Optional. The CDD to use for migration actions. Project path of the 
CDD (path relative to the root directory of the source project). 

-u Optional but if specified -c must also be specified. Specifies the 
name of the PU (within the specified CDD) that contains settings to 
be migrated. 

HTTP channel settings from this PU are migrated to all HTTP 
channel resources in the project.

Table 4   TIBCO BusinessEvents Studio Tools Options for Importing an Existing Project (Cont’d)

Option Description
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5. (If you imported the project to a directory in your default workspace, skip this 
step.) If the project directory is located outside the default workspace, 
uncheck the Use default location checkbox and browse to the parent directory 
of the project imported at the command line. 

6. Click Finish. The project folders appear in the Studio Explorer view.
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Migrating 3.x Projects

This section outlines how to migrate 3.x projects, after you install TIBCO 
BusinessEvents 5.1 (as explained in Chapter 1 through Chapter 3 of this guide).

Task A Import, Clean, and Validate the 3.x Project

1. Import the TIBCO Designer (3.x) project into TIBCO BusinessEvents Studio. 
See Importing a 3.x TIBCO Designer Project on page 58. 

If you will migrate from the Oracle Types backing store or from a Berkeley DB 
OM to the Cache OM with JDBC backing store, keep the 3.x project 

2. In TIBCO BusinessEvents Studio select Project > Validate to validate the 
project and then review the issues in the Problems tab and in the Error Log tab 
and resolve any errors. See Clean and Validate 3.x Projects on page 61.

Task B Configure Runtime Properties in the CDD File

Most of the configuration that was done in TRA files is now done in the CDD file. 
Ensure that all valid 3.x runtime settings (except JVM and system level properties) 
are configured in the CDD. Some properties are not relevant in the current 
version, and additional properties not used in 3.x have been added to the product. 
You may have to add some properties manually to CDD property sheets. Here are 
some tips:

• If you are migrating 3.0.0 projects that use the legacy Oracle Types backing 
store, you must first upgrade your 3.0.0 installation to the latest 3.x version 
and update the Oracle Types backing store schema. After the schema update 
you can then migrate the data to the JDBC backing store, which you configure 
in the 5.1 version project. 

• Berkeley DB object management is removed from the product in version 5.1. If 
you are migrating from Berkeley DB, see For Berkeley DB Object Management 
Users Only on page 38 for preliminary steps to take in order to change to 
Cache OM. 
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• Add runtime engine properties to the CDD file at the appropriate level for the 
scope of the property: 

— Cluster level for cluster-wide scope.

— Processing Unit level for engine-wide scope in the specified type of engine 
(Processing Unit). You will have to think about your engines differently, as 
running different kinds of agent classes. 

— Agent level to limit the scope to the agent class.

• TIBCO BusinessEvents properties that were configured in the TIBCO 
Designer TRA file generally go in the TIBCO BusinessEvents Studio TRA file: 

BE_HOME/studio/eclipse/configuration/studio.tra

• Remove the runtime properties that are now configured elsewhere from the 
TRA file and ensure that only JVM or system level properties remain. Leaving 
these properties in the TRA can cause problems at runtime.

See Understanding the CDD File (For 3.x Users) on page 56 for background 
information that helps you work with the CDD file.

Task C Check that be-engine.xml Settings are in the CDD File

You can change CDD file values at deploy-time without having to rebuild the 
EAR file. Therefore there is no need for the be-engine.xml file. (It was used to 
add properties to the TIBCO Administrator UI in order to make changes at deploy 
time.)

Check that all the properties from your 3.x be-engine.xml that are valid in 5.1 are 
present in the CDD file.

Task D Add Project Libraries (If Used)

Version 3.x project libraries containing entities (concepts, events and so on) are 
not compatible with project libraries in release 4.0.0 and higher, because the 
format for entities changed in the 4.0.0 release. They are not migrated.

(3.x project libraries that contain only shared resources will work in version 4.0.0 
and up, but that is not a common use for project libraries. The format of shared 
resources remains the same in 5.1).

If you want to continue to use the 3.x project libraries, recreate the libraries and 
add them to the 5.1 project build path after migration. Follow instructions in the 
section Working with Project Libraries, in Chapter 1, Project Tasks of TIBCO 
BusinessEvents Developer’s Guide.

Task E Reconfigure TIBCO BusinessEvents-ActiveMatrix BusinessWorks 
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Integration Projects (If Used)

Configuration of TIBCO BusinessEvents-ActiveMatrix BusinessWorks integration 
projects has changed. If a 3.x project contains TIBCO ActiveMatrix BusinessWorks 
or TIBCO Adapter resources, plan to use two projects: a TIBCO Designer project 
for the TIBCO Designer resources, and a TIBCO BusinessEvents Studio project. 
See Chapter 38, ActiveMatrix BusinessWorks Integration in TIBCO BusinessEvents 
Developer’s Guide for details.

Task F Migrate 3.x Decision Manager Projects (If Used)

If you want to continue to use decision tables, you must purchase the TIBCO 
BusinessEvents Decision Manager add-on product. 

In a Decision Manager 3.x project, decision tables were in a separate project called 
a decision project, with a .dp file extension (along with related files). Decision 
projects were maintained in a separate application that is no longer used. The 
decision projects provided the decision tables for the TIBCO Designer project that 
contained the virtual rule functions (implemented by the decision tables). 

To import 3.x decision projects you must first import the 3.x TIBCO Designer 
project into TIBCO BusinessEvents Studio as a TIBCO BusinessEvents Studio 
project. Then you import the related decision project into that TIBCO 
BusinessEvents Studio project. The decision table format is migrated to the 
current format during import.

1. Import the 3.x TIBCO Designer project into TIBCO BusinessEvents Studio as a 
TIBCO BusinessEvents Studio project. See Task A, Import, Clean, and Validate 
the 3.x Project, on page 50 for full details.

2. In TIBCO BusinessEvents Studio, select Import from the File menu. You see 
the Import wizard Select dialog.

3. Select TIBCO BusinessEvents > TIBCO BusinessEvents Decision Manager and 
click Next. You see the Import Decision Project dialog.

4. In the Project Location field, browse to and select the decision project (.dp) file 
for the decision project that relates to the TIBCO Designer project you 
imported in step 1. 

The TIBCO ActiveMatrix BusinessWorks processes used in the integration project 
do not appear in TIBCO BusinessEvents Studio. In version 3.x, both product UIs 
were implemented in TIBCO Designer, but since version 4.0, the TIBCO 
BusinessEvents UI has been implemented in Eclipse. 

Domain models are not imported while importing a decision project. 
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5. In the Projects field, select the TIBCO BusinessEvents Studio project that you 
created by importing the related TIBCO Designer project in step 1. 

The decision tables are now added to the TIBCO BusinessEvents Studio 
project.

6. If you will use RMS, create the RMS project and copy project files to the 
appropriate folder so the project can be checked out by Decision Manager UI 
users.

Task G Migrate 3.x Database Concepts and State Models (If Used)

If you want to continue to use database concepts or state models, you must 
purchase the TIBCO BusinessEvents Data Modeling add-on product. 

After importing the project, you must configure the Cluster Definition Descriptor 
(CDD) file to add the JDBC connection project path or paths, and enable database 
concepts on all engines (processing units) where you want to use them. Steps are 
as follows: 

1. Open the project’s CDD and select the Cluster tab > Database Concepts.

2. In the Database URIs field, add all JDBC shared resources used for creating 
database concepts. Click the plus sign to add a new row as needed, and add 
the project path to the resource.

3. Select the Processing Units tab (at the bottom of the window). Select each 
processing unit in turn and do one of the following:

— To enable database concepts, check the Enable Database Concepts 
checkbox. 

— To disable database concepts, uncheck the checkbox.

Task H Choose a Cache Provider and Configure Settings (Cache OM only)

Beginning with TIBCO BusinessEvents 5.0.0, Oracle Coherence is no longer 
provided with TIBCO BusinessEvents. An internal component, TIBCO 
BusinessEvents DataGrid, is used by default. See Migrating from Coherence to 
TIBCO BusinessEvents DataGrid Cache Provider on page 37 for important 
information about migration of Coherence functions. If you use cache OM, action 
is required:

When cache OM is used, the default mode for a cache cluster is Cache Only. 
However the default mode of a database concept is Memory Only. You can 
specify a mode explicitly by adding domain object overrides. See TIBCO 
BusinessEvents Data Modeling Developer’s Guide for complete details.
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• If you want to switch from Oracle Coherence to TIBCO BusinessEvents 
DataGrid, you must manually reconfigure the CDD file settings. See 
Chapter 24, Cache OM and Cluster Configuration in TIBCO BusinessEvents 
Developer’s Guide for details. 

• If you want to continue using Oracle Coherence as the cache provider, you 
must acquire a licensed copy of Oracle Coherence software and do some 
configuration. See Enabling Use of Oracle Coherence as the Cache Provider on 
page 55 for details.

• The property tangosol.coherence.distributed.localstorage is 
migrated automatically to the cache-provider-neutral property 
be.engine.cluster.isSeeder. However, a change in design makes this 
property redundant. Cache storage is now set at the processing unit level, 
using a checkbox labeled Enable Cache Storage. It is not possible to set this 
checkbox at migration time. To complete migration, remove the isSeeder 
property and instead configure cache storage for non-cache agents as needed 
use the processing unit setting Enable Cache Storage in the project CDD file. 
Note that enabling cache storage on non-cache agents is not recommended for 
production. It can be useful for testing and demonstration purposes.

Task I Migrate Legacy Oracle-only Backing Stores to JDBC Backing Store 

The legacy Oracle-only (Oracle Types) backing store is no longer supported. If 
you were using the legacy Oracle-only (Oracle Types) backing store, you must 
migrate to the current implementation. See Oracle Types to JDBC Backing Store 
Migration, page 63.

Task J (All Cases) Validate the Project in TIBCO BusinessEvents Studio

It is recommended that you validate the project in TIBCO BusinessEvents Studio 
after migration, to help ensure that the project is correctly configured. 

Certain validation checks were added after 4.0. So validating the project may 
reveal issues that were not caught in the earlier release from which you migrated.

Task K Rebuild EAR Files

As with any upgrade, you must rebuild all EAR files created with an earlier 
version. 
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Enabling Use of Oracle Coherence as the Cache Provider

If you want to use the Oracle Coherence cache provider, you must provide a fully 
licensed, supported version of the software. See the product readme file for 
supported version information. You must also enable Oracle Coherence as the 
cache provider, as explained below.

To Enable Oracle Coherence as the Cache Provider

1. Copy the coherence.jar file from your Oracle Coherence installation to 
BE_HOME/lib/ext/tcpl. 

(This location is preconfigured in the 
studio/eclipse/configuration/studio.tra classpath, as shipped. If you 
use a different location, update the classpath.)

2. Enable the Coherence category functions as follows:

a. Open the BE_HOME/studio/eclipse/configuration/studio.tra file 
for editing.

b. Change the setting of the following property to true (it is false as shipped):
TIBCO.BE.function.catalog.coherence=true

c. Save the file and restart TIBCO BusinessEvents Studio. 

For your information, log messages printed to the console at startup show the 
location of the files in use. See BE_HOME/bin/logs/cep-engine.log. 

You cannot use the coherence.jar file from an earlier TIBCO BusinessEvents 
release. 
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Understanding the CDD File (For 3.x Users)

Beginning with the 4.0.0 release, most runtime properties and other deploy-time 
settings are configured using a structured XML file called the Cluster Deployment 
Descriptor (CDD). A big advantage of this change is that you can change CDD file 
values at deploy-time without having to rebuild the EAR file (the CDD file used is 
stored outside the EAR file).

A multi-tab editor in TIBCO BusinessEvents Studio enables easy maintenance of 
this file. This section explains the role of the CDD file for the benefit of those 
migrating projects from 3.x. 

The EAR file now includes all resources In the current architecture, you do not 
select what resources to include in the EAR file. The EAR includes all project 
resources and can be very large. During runtime however, the resources are 
enabled (filtered) through the CDD Agent Classes and Collections tabs.

Read this section before beginning your migration. Also read related topics in 
TIBCO BusinessEvents Architect’s Guide and TIBCO BusinessEvents Getting Started.

Most Runtime Properties are Configured in the CDD File

3.x Configuration In 3.x (and earlier), runtime properties were set using individual properties set in 
one or more TRA files. In some cases, runtime properties were set in TIBCO 
Designer, specifically in the BAR resource, and some were set in the TIBCO 
Designer TRA file. 

5.1 Configuration Now only JVM-level properties (those that need to be used before the engine 
starts up) are set in the be-engine.tra file. Properties that were set in the TIBCO 
Designer TRA file (designer.tra) are now generally set in the studio.tra file:

BE_HOME/studio/eclipse/configuration/studio.tra

Other runtime properties are configured in the CDD file. The CDD file provides 
fields for all commonly used settings, and it has property sheets where you can 
add other properties as needed. The property sheets are available at various 
levels, cluster, processing unit, and agent, so that you can scope the effect of the 
property appropriately and provide overrides at lower levels.

See Property Migration Reference on page 68 for a list of 3.x runtime properties 
and their equivalent CDD settings or properties in the current version. 
Documentation about the CDD settings and properties is provided in the TIBCO 
BusinessEvents Developer’s Guide guide.
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Processing Units (Engines) and Agent Classes are Configured in the CDD File
In the CDD, you configure processing units (equivalent to an engine at runtime). A 
processing unit references the agent or agents you want to include in the 
processing unit (engine) at runtime. At deploy time you specify which processing 
units to deploy.

In 3.x agents were configured using individual properties in the TRA files. Each 
TRA file provided the configuration for one engine. 

Beginning with the 4.0.0 release, you configure all the processing units you need 
to deploy in a single CDD file. When you deploy an engine, you specify the 
processing unit to use. The processing unit configuration in the CDD determines 
which project resources and settings are used at runtime.

Some agents and processing units are created for you when you import a 3.x 
project into Studio based on 3.x information available. After you import the 
project into TIBCO BusinessEvents Studio, edit the CDD file to fully configure the 
agents and processing units as needed. 

Metadata Properties (Extended Properties) are Configured in the CDD File
The entity metadata properties (also known as extended properties) for cache and 
backing store are now configured in the CDD. Preloading configuration has also 
been simplified. This is explained in the migration sections. 
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Importing a 3.x TIBCO Designer Project

You can directly import 3.x projects using the TIBCO BusinessEvents Studio user 
interface and save it as a current version project. You can also import a 3.x project 
at the command line. Import from versions earlier than 3.x is not supported.

After you import the project, see Clean and Validate 3.x Projects on page 61 for the 
next step.

Importing a 3.x Project into TIBCO BusinessEvents Studio
To import 3.x projects into TIBCO BusinessEvents Studio, follow the procedure 
below. 

To Import a 3.x Project in TIBCO BusinessEvents Studio

1. Start TIBCO BusinessEvents Studio. In Windows, click Start > All Programs > 
TIBCO > YourEnvironment > TIBCO BusinessEvents 5.1 > TIBCO 
BusinessEvents Studio.

2. From the File menu, select Import. You see the Import wizard Select dialog.

3. Select TIBCO BusinessEvents > TIBCO Designer and click Next. You see the 
TIBCO Designer Project Import Wizard.

4. In the Archive Location field, browse to the location of the TIBCO Designer 
project and select its EAR file or its vcrepo.dat file.

5. In the Project Name field, enter a name for the TIBCO BusinessEvents Studio 
project. The default value is the original project name.
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6. Specify a project location, or use the default workspace.

7. Click Finish. 

The progress bar displays while the import is done. The status bar at the bottom 
of the window also displays progress. When the import is complete, you see the 
project folders in the Studio Explorer view.

Importing a TIBCO BusinessEvents 3.x Project at the Command Line
This utility imports a TIBCO BusinessEvents 3.x (TIBCO Designer) project at the 
command line. Projects imported using this command-line utility do not run in 
the context of Eclipse (TIBCO BusinessEvents Studio). An additional step is 
required if you want to open the project in TIBCO BusinessEvents Studio, as 
explained below. 

To Import a 3.x Project at the Command Line

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.

2. Execute a command with the following format (all on one line) at a command 
prompt:

studio-tools -core importDesigner -d designerProjDir [-n studioProjName] -p studioProjDir

For example:

studio-tools -core importDesigner -d C:\FT\FT_Project -n FTImport -p 
c:\myWorkspace\FTImported

When the import has completed successfully, you see a message in the command 
window:

Imported the Designer Project successfully.

Table 5, TIBCO BusinessEvents Studio Tools Options for Importing 3.x TIBCO 
Designer Projects, provides detailed information about the options. 

See To Open a Project Imported at the Command Line in TIBCO BusinessEvents 
Studio, page 60 for a procedure you must do if you want to open the project in 
TIBCO BusinessEvents Studio.

Table 5   TIBCO BusinessEvents Studio Tools Options for Importing 3.x TIBCO Designer Projects

Option Description

-core importDesigner Within the core category of operations, specifies the 
importDesigner operation for importing a TIBCO BusinessEvents 
3.x (TIBCO Designer) project.
 TIBCO BusinessEvents Installation



60 | Chapter 4  Migrating Projects from Earlier Versions
To Open a Project Imported at the Command Line in TIBCO BusinessEvents 
Studio 

To open a project imported at the command line, you must add it as a new project.

1. Start TIBCO BusinessEvents Studio. In Windows, click Start > All Programs > 
TIBCO > YourEnvironment > TIBCO BusinessEvents 5.1 > TIBCO 
BusinessEvents Studio.

2. From the File menu select New > Project. You see the New Project — Select a 
Wizard dialog. 

3. Select TIBCO BusinessEvents > Studio Project and click Next.

4. In the Project Name field, enter the directory name where the imported project 
is located. (This is used as the project name.)

5. (If you imported the project to a directory in your default workspace, skip this 
step.) If the project directory is located outside the default workspace, 
uncheck the Use default location checkbox and browse to the directory of the 
project imported at the command line. 

6. Click Finish. The project folders appear in the Studio Explorer view.

-d Absolute path to the TIBCO Designer project directory (the .dat file 
can be included but is not required). Import of release 3.x projects is 
supported. 

-n Optional. Specifies the name of the TIBCO BusinessEvents 4.x 
project (TIBCO BusinessEvents Studio project). If not specified, the 
TIBCO BusinessEvents Studio 3.x project name is used.

-p Absolute path to the TIBCO BusinessEvents 4.x project directory (the 
TIBCO BusinessEvents Studio project). The directories in the path 
are created if they do not exist.

Table 5   TIBCO BusinessEvents Studio Tools Options for Importing 3.x TIBCO Designer Projects (Cont’d)

Option Description
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Clean and Validate 3.x Projects

This section explains how to clean and validate a 3.x project, and how to fix errors. 
Also see Project Migration Overview on page 36 for none-release-specific 
information.

Clean and Validate the Project

After you import the 3.x project into TIBCO BusinessEvents Studio Explorer, do 
the following:

1. Highlight the project name in TIBCO BusinessEvents Studio and select Project 
> Clean. At the Clean dialog, click Clean projects selected below, and then 
select the imported project. Click OK. 

All build problems and build states are discarded. The project is rebuilt from 
scratch.

2. Highlight the project name in Studio Explorer and select Project > Validate to 
validate the project. 

You may see some common validation errors that are addressed in the following 
sections. If you see additional errors that you cannot resolve, contact your TIBCO 
representative for assistance.

Fixing Ambiguous Reference Errors (Unqualified References) 
During migration, duplicate name references can cause issues. If the project 
contains unqualified references to rules, rule functions, or ontology types, and 
any of the rules, rule functions, or ontology types have the same simple name, 
duplicate name validation errors will result. 

In the TIBCO BusinessEvents Studio Problems tab, you may see listings for these 
issues, such as the following:

Ambiguous reference. Reference must be qualified, as multiple 
elements exist with the same name [/sharedResources/Element, 
Rules/Element, Concepts/Element]

One source of this issue is that beginning with the 4.0.0 release, rules are separate 
resources, whereas in the 3.x product, they exist within ruleset resources. 

To Resolve the Issue Qualify all such ambiguous references.

Executing Project > Clean also performs validation, if you check Project > Build 
Automatically. In this case you do not have to do step 2.
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Fixing XSLT Mapper Errors
If you have used the XPath (XSLT) mapper in TIBCO Designer, there could be 
errors that prevent a clean validation of the project after it is imported. 

In 3.x, XSLT Mapper errors were not reported during project validation. This 
validation has been added, beginning with the 4.0.0 release. Therefore, any 
mapper errors must be fixed before project validation can be successful. These 
errors existed in the 3.x product, though they may not have caused any runtime 
problems. 

To Resolve the Issue In TIBCO BusinessEvents Studio double-click those items in 
the Problems view. The rule editor displays the corresponding rule or rule 
function. In the editor. Check for red error indicators on lines containing function 
mapping. Where you see an error indicator on a line containing Mapper code, 
Ctrl-click the underlined argument text to open the Function Argument Mapper 
dialog. Click the Mapper Check and Repair (check-mark icon) button. 

Some errors can be auto-fixed: Click the validate option (the check mark) in the 
mapper. You see the Mapper Check and Repair dialog. Select the items you want 
to fix and click OK. (Using auto-fix is harmless even if the errors cannot be 
auto-fixed.) Then manually fix any errors that cannot be autofixed. For example, 
errors such as undefined variable errors cannot be fixed automatically. 
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Oracle Types to JDBC Backing Store Migration 

The Oracle-only (Oracle Types) backing store is not supported in 5.0.0 If you were 
using this backing store implementation in your prior version of TIBCO 
BusinessEvents, implement a JDBC backing store and migrate your data to it as 
explained in this section. 

If you were using the JDBC backing store in any release, no migration is required.

Migration steps depend on whether you are migrating from 3.0.0, or from a later 
3.x release, or from a 4.x release, as indicated in the tasks below.

The data migration process uses two backing stores, the legacy backing store and 
the new JDBC backing store. However after migration, you'll have one backing 
store. Use of two backing stores is limited to migration procedures.

If you plan to make any schema changes, make them after the backing store data 
is migrated successfully, following directions in TIBCO BusinessEvents Developer’s 
Guide.

Task A All Versions

Back up your backing store data.

Task B 3.0.0 Only: Upgrade to 3.x and Update the Legacy Backing Store 
Schema

New TIBCO BusinessEvents metadata tables were added to the backing store 
schema in version 3.0.1. If you are upgrading from version 3.0.0, you first must 
upgrade to the latest 3.x version before you migrate data to a JDBC backing store.

1. Upgrade from 3.0.0 to the latest 3.x version.

2. If the deployed application is running, gracefully shut down all agents and 
cache servers before you proceed.

3. Login to the Oracle server as be_user, password be_user (or whatever 
username and password you are using, as set in the 
initialize_database.sql script). 

4. Navigate to the location of the scripts (by default in BE_HOME/bin) and open 
an SQLPlus prompt. Identify yourself as the user you logged in as. 

5. At the SQL prompt, type the following to run the script:

During migration, you must keep the JDBC Connection resource for the existing 
Oracle-only backing store, and you must be able to connect to it.
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@create_tables.sql 

Running this script does not affect any existing tables (therefore there is no need 
to run be-oradeploy.exe). Your database tables are now configured.

Task C 3.x Only: Import Projects into TIBCO BusinessEvents Studio

Import the project into TIBCO BusinessEvents Studio and ensure that the 
migrated project is configured correctly. See Migrating 3.x Projects on page 50 for 
full details. 

Task D Add a JDBC Backing Store

In this task, you set up a new backing store, including creation of a new JDBC 
Connection resource. 

1. Add the JDBC backing store, following instructions in Chapter 30, JDBC 
Backing Store Setup, which is in TIBCO BusinessEvents Developer’s Guide.

2. It's a good idea to open your project again in TIBCO BusinessEvents 
Studioand test both the JDBC connections. If you need to make corrections to 
the connections, do so before you build the EAR.

3. When you have set up the new backing store, including the JDBC connection 
and CDD settings, Rebuild the EAR file.

Task E Set Up the TIBCO BusinessEvents TRA File

Open the BE_HOME/bin/be-migration.tra file and specify appropriate values 
for the properties shown below, with example values. For notes on the properties 
see Backing Store Data Migration Property Reference on page 65.

# Oracle/JDBC Migration Properties
be.migration.batchsize 1000
be.migration.workersize 16
be.migration.objecttable true
be.migration.target.type jdbc

# Database URLs
# Source database:
be.oracle.dburi.count 1
be.oracle.dburi.0 /Resources/myORCL.sharedjdbc
be.oracle.dburi.pool.initial.0 5
be.oracle.dburi.pool.min.0 5
be.oracle.dburi.pool.max.0 10

Do not remove the JDBC Connection resource for the Oracle-only backing store 
database from your project until you have completed all migration tasks. 
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# Target database:
be.jdbc.dburi.count 1
be.jdbc.dburi.0 /Resources/myJDBC.sharedjdbc
be.jdbc.dburi.pool.initial.0 5
be.jdbc.dburi.pool.min.0 5
be.jdbc.dburi.pool.max.0 10

Task F Run the Data Migration Process

1. Open a command prompt, navigate to BE_HOME/bin, and execute the 
following command:

be-migration -copy -ear EARFile

Wait until the process is complete

2. If you set the property be.migration.objecttable=false in Task E then 
you must manually migrate OBJECTTABLE table contents. (Use your DBMS 
product documentation for this task.)

3. You can now start the TIBCO BusinessEvents engine and use the JDBC 
backing store with the migrated data. 

Task G Remove Legacy Backing Store and JDBC Connection

When you have tested the migration and are sure that all is working well, you can 
remove the legacy backing store JDBC connection and archive, or otherwise 
remove, the legacy backing store files.

Backing Store Data Migration Property Reference

Table 6   Oracle-Only to JDBC Backing Store Data Migration

Property Notes

be.migration.batchsize

Defines the database batch size to be used during the migration process. The best 
size depends on the database configuration.

Default is: 200
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be.migration.workersize

Defines how many concurrent threads to use during the migration process. Set to 
the number of processors available.

Default is: 10

be.migration.objecttable

If the existing Oracle backing store contains a large amount of data, the migration 
process can take many hours to complete. If this is the case, you can shorten the 
process using this property. 

When this property is set to false, the migration process ignores the data contained 
in OBJECTTABLE table. Skipping this table can shorten the migration time 
considerably. 

If you skip migration of the OBJECTTABLE table, you must then copy this table from 
the Oracle to the JDBC backing store database using other tools (or simple SQL 
scripts).

Default is true.

be.migration.target.type

Defines which type of schema to use for the new backing store. Values are: 

jdbc: The JDBC backing store schema. Use this value for migrating from an Oracle 
backing store to a JDBC backing store (the procedure documented in this section).

oracle: No longer valid as an option.

Default is jdbc.

Table 6   Oracle-Only to JDBC Backing Store Data Migration

Property Notes
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Chapter 5 Property Migration Reference

This chapter contains a reference table to assist you in locating the 4.x properties 
or UI settings that correspond to 3.x properties. 

Note that many logging properties have been replaced and are not directly 
migrated.

Topics

• Property Migration Reference, page 68
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Property Migration Reference

The main properties used in prior releases are listed on the left, with their current 
version equivalents on the right. Note that it may be possible for properties listed 
as going in Cluster tab > Properties to be added to a lower-level property sheet, 
generally the processing unit property sheet, as appropriate. See TIBCO 
BusinessEvents Developer’s Guide for more details on configuring the Cluster 
Definition Descriptor (CDD) file.

Deprecated and Unused Properties Properties that are deprecated in this release or 
are not used in this release are noted below. A list of unused properties from older 
supported versions of TIBCO BusinessEvents is provided in Appendix A, 
Deprecated and Unused Properties, on page 81.

Table 7   Property Migration Reference  (Sheet 1 of 13)

Earlier Version Property (mostly 3.x and 4.x) 5.1 CDD Editor

Agent Group Name (in BAR resource) Agent Classes tab > 
AgentClassName > Agent Class 
Name

Agent.AgentGroupName.cacheOpsQueueSize No longer used

Agent.AgentGroupName.checkDuplicates Agent Classes Tab > 
AgentClassName > Check for 
Duplicates

Agent.AgentGroupName.concurrentwm Agent Classes tab > 
AgentClassName > Concurrent RTC

Agent.AgentGroupName.dbOpsBatchSize Agent Classes Tab > 
AgentClassName > Properties

Agent.AgentGroupName.dbOpsQueueSize Agent Classes Tab > 
AgentClassName > Properties

Agent.AgentGroupName.dbthreadcount Agent Classes Tab > 
AgentClassName > Properties

Agent.AgentGroupName.key Processing Units tab > PUName > 
Agents > Key

Agent.AgentGroupName.maxActive Agent Classes tab > 
AgentClassName > Max Active
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Agent.AgentGroupName.priority Processing Units tab > PUName > 
Agents table > Priority

Agent.AgentGroupName.recoveryPageSize Agent Classes Tab > 
AgentClassName > Properties

Agent.AgentGroupName.threadcount Agent Classes Tab > 
AgentClassName > Properties 

Agent.AgentGroupName.l1CacheSize

be.agent.query.localcache.maxelements

Agent Classes tab > 
AgentClassName > Max Size 

be.oracle.dburi.0 (No longer used)
be.jdbc.dburi.0

Cluster tab > [OM Type - Cache] 
> Backing Store > Connection > 
URI

be.agent.cache.specialom Agent Classes tab > Cache Agent 
> Properties

be.agent.cache.specialom.maxthreads Agent Classes tab > Cache Agent 
> Properties

be.agent.query.localcache.evictseconds Agent Classes tab > 
AgentClassName > Eviction Time

be.agent.query.localcache.prefetchaggressive Agent Classes Tab > 
QueryAgentClassName Properties

be.backingstore.dburi.pool.initial.0 Cluster tab > Backing Store > 
Connection > Initial Size

be.backingstore.dburi.pool.inactivityTimeout.0

(Applicable only if Oracle strategy is selected)

Cluster tab > Properties

(Backing store properties)

be.backingstore.dburi.pool.waitTimeout.0

(Applicable only if Oracle strategy is selected)

Cluster tab > Properties

(Backing store properties)

be.jdbc.readtimeout (No longer used)
be.backingstore.readtimeout

(Applicable only if Oracle strategy is selected)

Cluster tab > Properties

Table 7   Property Migration Reference  (Sheet 2 of 13)

Earlier Version Property (mostly 3.x and 4.x) 5.1 CDD Editor
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be.oracle.dburi.pool.enforce.0 (No longer used)
be.jdbc.dburi.pool.enforce.0

Cluster tab > [OM Type - Cache] 
> Backing Store > Enforce Pools

be.oracle.dburi.pool.initial.0 (No longer used)
be.jdbc.dburi.pool.initial.0

Cluster tab > [OM Type - Cache] 
> Backing Store > Connection > 
Initial Size

be.oracle.dburi.pool.max.0 (No longer used)
be.jdbc.dburi.pool.max.0

Cluster tab > [OM Type - Cache] 
> Backing Store > Connection > 
Max Size

be.oracle.dburi.pool.min.0 (No longer used)
be.jdbc.dburi.pool.min.0

Cluster tab > [OM Type - Cache] 
> Backing Store > Connection > 
Min Size

be.channel.tibjms.queue.disabled Agent Classes tab > 
AgentClassName > Properties

be.channel.tibjms.topic.disabled Agent Classes tab > 
AgentClassName > Properties

be.dbconcepts.connection.check.interval Cluster tab > Database Concepts 
> Check Interval

be.dbconcepts.connection.retry.count Cluster tab > Database Concepts 
> Retry Count

be.dbconcepts.dburi Cluster tab > Database Concepts 
> Database URIs

be.dbconcepts.pool.inactivityTimeout Cluster tab > Database Concepts 
> Inactivity Timeout

be.dbconcepts.pool.initial Cluster tab > Database Concepts 
> Initial Size

be.dbconcepts.pool.max Cluster tab > Database Concepts 
> Max Size

be.dbconcepts.pool.min Cluster tab > Database Concepts 
> Min Size

Table 7   Property Migration Reference  (Sheet 3 of 13)

Earlier Version Property (mostly 3.x and 4.x) 5.1 CDD Editor
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be.dbconcepts.pool.PropertyCheckInterval Cluster tab > Database Concepts 
> Property Check Interval

be.dbconcepts.pool.waitTimeout Cluster tab > Database Concepts 
> Wait Timeout

be.engine.cacheServer Deprecated

Agent Classes Tab > Agent class 
type: Cache 

be.engine.cacheServer.channel.disable Processing Units tab > PUname > 
Properties

Not used

be.engine.cluster.cleanup Cluster tab > Properties (backing 
store related)

be.engine.limited.cache.back.size.limit Cluster tab > Object Management 
(Cache) > Entity Cache Size

be.engine.limited.objectTable.back.size.limit Cluster tab > Object Management 
(Cache) > Object Table Cache Size

be.engine.cluster.isCacheLimited Cluster tab > Domain Objects > 
Default > Is Cache Limited

Cluster tab > Domain Objects > 
Overrides > Entity URI > Is Cache 
Limited

be.engine.cluster.EntityClassName.preload Cluster tab > Domain Objects > 
Overrides > URI > Preload 
Entities

be.engine.cluster.EntityClassName.preload.fetchsize Cluster tab > Domain Objects > 
Overrides > URI > Preload Fetch 
Size

be.engine.cluster.externalClasses.classLoader Agent Classes > Inference Agent 
> Properties

For TIBCO BusinessEvents 
Decision Manager

Table 7   Property Migration Reference  (Sheet 4 of 13)

Earlier Version Property (mostly 3.x and 4.x) 5.1 CDD Editor
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be.engine.cluster.externalClasses.path Agent Classes tab > Inference 
Agent > Properties

For TIBCO BusinessEvents 
Decision Manager

be.engine.cluster.hasBackingStore Cluster tab > [OM Type - Cache] 
> Backing Store > Persistence 
Option - Shared All [Oracle/SQL 
Server/Berkeley DB] or Shared 
Nothing

be.engine.cluster.isCacheAside Cluster tab > [OM Type - Cache] 
> Backing Store > Cache Aside

be.engine.cluster.isCacheLimited Cluster tab > Properties

Limited cache is used by default 
if backing store is enabled. 

Related setting: Entity metadata 
> Is Cache Limited

be.engine.cluster.isObjectCacheFullyLoaded Cluster tab > Properties

be.engine.cluster.minCacheServers Cluster tab > [OM Type - Cache] 
> Cache Agent Quorum

be.engine.cluster.multiEngineOn Deprecated

Processing Unit > Properties

True by default.

be.engine.cluster.multisite Not used

be.engine.cluster.persistenceProvider Used in version 5.0.1. Replaced 
by Cluster tab > Backing Store. 
Persistence Option Shared All, 
Databasy Type Berkeley DB

be.persistenceprovider.bdb.directory Used in version 5.0.1. Replaced 
by Cluster tab > Backing Store > 
Shared All > Berkeley DB

Table 7   Property Migration Reference  (Sheet 5 of 13)

Earlier Version Property (mostly 3.x and 4.x) 5.1 CDD Editor
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be.engine.cluster.preload Not used. UI supersedes need for 
this property. See other Preload 
properties.

be.engine.cluster.EntityClassName.preload
be.engine.cluster.preload.handles
be.engine.cluster.preload.fetchSize

Due to redesign, the properties 
do not all map exactly to the 
current UI. Entity metadata 
properties were also used to 
define preloading behavior. They 
are no longer used.

Cluster tab > [OM Type - Cache] 
> Domain Objects (Default and 
override settings): Preload 
Entities, Preload Handles, 
Preload Fetch Size.

be.engine.cluster.smtimeout.pollInterval Cluster tab > Properties

be.engine.cluster.smtimeout.refreshAhead Cluster tab > Properties

be.engine.cluster.recovery.distributed No longer used. Recovery is 
always distributed.

be.engine.externalClasses.packageExclusions No longer needed. TIBCO 
BusinessEvents Decision 
Manager property.

be.engine.coherence.useAutomatedRecovery Cluster tab > Properties

be.engine.hotDeploy.enabled Processing Unit > Hot Deploy

be.engine.kernel.unifiedExtIdMap Agent Classes tab > Inference 
Agent > Properties

be.engine.name (in be-engine.tra file)

be.engine.om.berkeleydb.cacheweight.agent Not supported in 5.1

be.engine.om.berkeleydb.dbenv Not supported in 5.1

be.engine.om.berkeleydb.internalcachepercent Not supported in 5.1

be.engine.om.eventcache.defaultmaxsize Not supported in 5.1

Table 7   Property Migration Reference  (Sheet 6 of 13)

Earlier Version Property (mostly 3.x and 4.x) 5.1 CDD Editor
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be.engine.om.eventcache.maxsize.agent Agent Classes Tab > Inference 
Agent > Properties

be.engine.profile.delimiter Cluster tab > Properties

be.engine.tangosol.oracle.prefetch (No longer used) Cluster tab > Domain Objects > 
Default > Preload Fetch Size

be.ft.cluster.name Deprecated

be.ft.enabled Deprecated

be.ft.failback.waitmilliseconds Deprecated

be.ft.failover.waitmilliseconds Deprecated

be.ft.nodename Deprecated

be.ft.priority Deprecated

be.hawk.microagent.name Agent Classes tab > Agent Class > 
Properties

be.http.compression HTTP channel resource > 
Advanced tab > Compression

be.http.dnsLookups HTTP channel resource > 
Advanced tab > Enable DNS 
Lookups

be.http.docPage HTTP channel resource > 
Advanced tab > Document Page

For TIBCO BusinessEvents 
Views:
be.agent.dashboard.http.doc
page

Table 7   Property Migration Reference  (Sheet 7 of 13)

Earlier Version Property (mostly 3.x and 4.x) 5.1 CDD Editor
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be.http.docRoot HTTP channel resource > 
Advanced tab > Document Root

For TIBCO BusinessEvents 
Views:
be.agent.dashboard.http.doc
root

be.http.maxKeepAliveRequests HTTP channel resource > 
Advanced tab > Max KeepAlive 
Requests

be.http.maxProcessors Processing Units tab > 
AgentClassName > Http Properties 
> Max Processors

be.http.maxHttpHeaderSize HTTP channel resource > 
Advanced tab > Max HTTP 
Header Size

be.http.maxPostSize HTTP channel resource > 
Advanced tab > Max HTTP Post 
Size

be.http.maxSavePostSize HTTP channel resource > 
Advanced tab > Max HTTP Save 
Post Size

be.http.maxSpareThreads HTTP channel resource > 
Advanced tab > Max Spare 
Threads

be.http.minSpareThreads HTTP channel resource > 
Advanced tab > Min Spare 
Threads

be.http.compressableMimeType HTTP channel resource > 
Advanced tab > Compressible 
Mime Types

be.http.restrictedUserAgents HTTP channel resource > 
Advanced tab > Restricted User 
Agents
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be.http.useBodyEncodingForURI HTTP channel resource > 
Advanced tab > Use Body 
Encoding for URI

be.jdbc.cacheLoaderClass
com.tibco.be.jdbcstore.BECoherenceJdbcStore
com.tibco.be.oracle.BECoherenceOracleStore

No longer used.

Class loader is implicitly selected 
depending on other backing store 
configuration choices.

be.jdbc.database.type Cluster tab > [OM Type - Cache] 
> Backing Store >

be.jdbc.dburi.strategy.0 Cluster tab > [OM Type - Cache] 
> Backing Store > Strategy

be.jdbc.readtimeout (No longer used) Cluster tab > Properties

(Backing store properties. Note: 
replaced by 
be.backingstore.readtimeout 

— see in this table.)

be.jms.reconnect.msgCodes Agent Classes tab > Inference 
Agent > Properties

be.jms.reconnect.timeout Agent Classes tab > 
AgentClassName > Properties

be.locale.country Not used.

be.locale.language Not used.

be.locale.variant Not used.

be.network.mode.standalone (For query agents) No longer 
used. See TIBCO BusinessEvents 
Query Developer’s Guide for new 
configuration.

be.oracle.commitSize Cluster tab > Properties

See 
be.backingstore.commitSize
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be.oracle.dburi.active.0 Not used

be.oracle.dburi.pool.inactivityTimeout.0 No longer used

See be.backingstore.
dburi.pool.inactivityTimeout.0

be.oracle.dburi.pool.waitTimeout.0 No longer used.

See be.backingstore.
dburi.pool.waitTimeout.0

be.oracle.debug No longer used.

be.trace.layout.class.arg Collections > Log Configuration 
> configname > Custom Line 
Layout > Arguments

be.trace.layout.class.name Collections > Log Configuration 
> configname > Custom Line 
Layout > Class

be.trace.log.append Collections tab > Log 
Configurations> Files section > 
Append

be.trace.log.enable Collections tab > Log 
Configurations> Files section > 
Enable

be.trace.log.fileName Collections tab > Log 
Configurations > Files section > 
Name

be.trace.roles Collections tab > Log 
Configurations > Roles

The format has also changed. See 
TIBCO BusinessEvents Developer’s 
Guide for details.

be.trace.term.enable Collections tab > Log 
Configurations > Send to 
Terminal section > Enable
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be.trace.log.maxnum 

Note: TIBCO BusinessEvents 3.x used this property and not 
engine.Log.MaxNum.

Collections tab > Log 
Configurations > Files section > 
Max number

be.trace.log.maxsize 

Note: TIBCO BusinessEvents 3.x used this property and not 
engine.Log.MaxSize.

Collections tab > Log 
Configurations > Max size

Agent.AgentGroupName.cacheTxn.updateCache Agent Classes tab > 
AgentClassName > Properties

Checkpoint Interval (in BAR resource) Cluster Tab [OM Type - Berkeley 
DB] > Checkpoint Interval

com.tibco.cep.runtime.channel.payload.validation Cluster tab > Properties (May be 
more likely at agent class level)

com.tibco.cep.runtime.scheduler.default.numThreads Agent tab > Shared Queue > 
Thread Count

com.tibco.cep.runtime.scheduler.queueSize Agent tab > Shared Queue > 
Queue Size

com.tibco.tibjms.connect.attempts Agent Classes tab > 
AgentClassName > Properties

com.tibco.tibjms.naming.security_protocol Agent Classes tab > Inference 
Agent > Properties

Database Environment Directory (in BAR resource) Cluster Tab [OM Type - Berkeley 
DB] > Database Environment 
Directory

Delete Retracted Objects from Database (in BAR resource) Cluster Tab [OM Type - Berkeley 
DB] > Delete Retracted Objects 
from Database

Do not Recover on Restart (in BAR resource) Cluster Tab [OM Type - Berkeley 
DB] > Do Not Recover on Restart

Engine.FT.ActivationDelay Deprecated
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Engine.FT.ActivationInterval Deprecated

Engine.FT.GroupName Deprecated

Engine.FT.HeartbeatInterval Deprecated

Engine.FT.UseFT Deprecated

Engine.FT.Weight Deprecated

Engine.Log.Dir Collections tab > Log 
Configurations

Hawk.AMI.DisplayName Agent Classes tab > Agent Class > 
Properties

java.net.preferIPv4Stack Cluster tab > Properties

objectTable.back.size.limit Cluster tab > Properties

Property Cache Size (in BAR resource) Cluster Tab [OM Type - Berkeley 
DB] > Property Cache Size

Schedule a checkpoint if outstanding DB ops greater than (in 
BAR resource)

Cluster Tab [OM Type - Berkeley 
DB] > Checkpoint Ops Limit

tangosol.coherence.cacheconfig No longer used. Autoassigned.

tangosol.coherence.cluster Cluster tab > General > Cluster 
Name 
(Also used for TIBCO 
BusinessEvents DataGrid cache 
provider cluster name)

tangosol.coherence.clusteraddress Cluster tab > Properties

tangosol.coherence.clusterport Cluster tab > Properties.

tangosol.coherence.distributed.backupcount Cluster tab > Object Management 
(Cache) > Number of Backup 
Copies
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tangosol.coherence.distributed.localstorage

(In 5.0, also used for TIBCO BusinessEvents DataGrid property 
be.engine.cluster.isSeeder)

Process Units tab > Enable Cache 
Storage

tangosol.coherence.distributed.threads Cluster tab > Properties.

tangosol.coherence.localhost Cluster tab > Properties

tangosol.coherence.localport Cluster tab > Properties

tangosol.coherence.log Processing Units tab > PUName > 
Properties

tangosol.coherence.log.level Processing Units tab > PUName > 
Properties

tangosol.coherence.log.limit Processing Units tab > PUName > 
Properties

tangosol.coherence.ttl Cluster tab > Properties

tangosol.coherence.wkan Cluster tab > Properties

tangosol.coherence.wkan.port Cluster tab > Properties

tibco.be.property.datatype.null.value Cluster tab > Properties.

Used for special handling of null 
properties and values.

tibco.bwengine.name Processing Units tab > PUName > 
Properties

tibco.clientVar.<GlobalVariable> Cluster/PU/Agent level 
properties
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Appendix A Deprecated and Unused Properties

The following TIBCO BusinessEvents engine properties were deprecated or made 
obsolete (not used) in an earlier release of TIBCO BusinessEvents. Properties 
newly deprecated or not used in the current release are noted in Chapter 5, 
Property Migration Reference, on page 67.

Table 8   Deprecated and Unused Engine Properties (Sheet 1 of 3)

Property Description 

be.engine.cluster.externalClasses.packageexclusions

Obsolete property. Used to exclude non-decision table classes when working with 
generated class files. Now only decision table classes are generated. Removed in 
version 5.1.0.

be.engine.cluster.cacheType

Deprecated property. Ignored if present. In 3.0.0, this property specifies which of 
the following provided caching schemes to use: dist-unlimited-bs, 
dist-limited-bs, or dist-unlimited-nobs (default) 

be.engine.cluster.cacheType

Deprecated property. Ignored if present. In 3.0.0, this property specifies which of 
the following provided caching schemes to use: dist-unlimited-bs, 
dist-limited-bs, or dist-unlimited-nobs (default) 

be.engine.om.recovery.threads

Not used in this release. Ignored if present.

be.ft.cluster.name

Deprecated property. 

be.ft.enabled

Deprecated property. 
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be.ft.failback.waitmilliseconds 
be.ft.failover.waitmilliseconds 

Deprecated Properties. These properties were introduced in a 2.x release to define 
a wait period, ensuring that cache was fully initialized before failing over to a 
secondary or failing back to the recovered primary. 

be.ft.node.name

Deprecated property. 

be.ft.priority

Deprecated property. 

be.locale.country 

Sets the country code to use for localization. Use upper case. Uses the ISO 3166 
standard. 

Note: TIBCO BusinessEvents is not fully localized in this release.

be.locale.language 

Sets the language code to use for localization. Uses the ISO 639 standard. 

Note: TIBCO BusinessEvents is not fully localized in this release.

be.locale.variant 

Optional extension to the locale language, for example, if you set 
be.locale.language to en, you might set be.locale.variant to US, which is 
interpreted as en_US

Note: TIBCO BusinessEvents is not fully localized in this release.

com.tibco.be.jdbcstore.BECoherenceJdbcStore
com.tibco.be.oracle.BECoherenceOracleStore

The above properties specified the cache loader class for backing stores. Later there 
was a Cache Loader Class setting, removed in 5.0. Now the cache loader class value 
is set internally.

Table 8   Deprecated and Unused Engine Properties (Sheet 2 of 3)
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be.trace.publish.enable 
be.trace.publish.subject 
be.trace.publish.daemon 
be.trace.publish.network 
be.trace.publish.service 

Deprecated properties. The above properties are ignored by the engine. Instead 
use current settings in the CDD. See the CDD Collections Tab Log Configurations 
Settings Reference section in TIBCO BusinessEvents Developer’s Guide for the current 
logging properties.

be.trace.log.dir 
be.trace.enable

Deprecated properties. The above properties are still used by the engine if found 
in the TRA or CDD file. However, do not use these properties. Instead use current 
settings in the CDD. See the CDD Collections Tab Log Configurations Settings 
Reference section in TIBCO BusinessEvents Developer’s Guide for the current logging 
settings.

Engine.Log.MaxNum
Engine.Log.MaxSize

These properties are set by TIBCO Administrator during deployment. Do not set 
them in your projects. 

Engine.FT.UseFT
Engine.FT.Groupname
Engine.FT.Weight

Deprecated properties. Were used for In Memory OM fault tolerance in 3.x. 
Instead, configure for Cache OM, but use the Memory Only mode for all objects. 
See also be.ft.nodename which was used for the same purpose.

tangosol.coherence.cacheconfig

Not needed except as advised by TIBCO Support for customization purposes.

Table 8   Deprecated and Unused Engine Properties (Sheet 3 of 3)
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Agent.AgentGroupName.cacheTxn.updateCache 78
Agent.AgentGroupName.checkDuplicates 68
Agent.AgentGroupName.concurrentwm 68
Agent.AgentGroupName.key 68
Agent.AgentGroupName.l1CacheSize 69
Agent.AgentGroupName.maxActive 68
Agent.AgentGroupName.priority 69
Agent.AgentGroupName.recoveryPageSize 69
Agent.AgentGroupName.threadcount 69
AIX, configuring for 64-bit mode 32

B

BE_HOME xvi
be.agent.cache.specialom 69
be.agent.cache.specialom.maxthreads 69
be.agent.dashboard.http.docpage 74
be.agent.dashboard.http.docroot 75
be.agent.query.localcache.evictseconds 69
be.agent.query.localcache.maxelements 69
be.agent.query.localcache.prefetchaggressive 69
be.backingstore.dburi.0 69
be.backingstore.dburi.pool.inactivityTimeout.0 69
be.backingstore.dburi.pool.initial.0 69
be.backingstore.dburi.pool.waitTimeout.0 69, 77, 77

be.backingstore.readtimeout.0 69
be.channel.tibjms.queue.disabled 70
be.channel.tibjms.topic.disabled 70
be.dbconcepts.connection.check.interval 70
be.dbconcepts.connection.retry.count 70
be.dbconcepts.dburi 70
be.dbconcepts.pool.inactivityTimeout 70
be.dbconcepts.pool.initial 70
be.dbconcepts.pool.max 70
be.dbconcepts.pool.min 70
be.dbconcepts.pool.PropertyCheckInterval 71
be.dbconcepts.pool.waitTimeout 71
be.engine.cacheServer 71
be.engine.cacheServer.channel.disable 71
be.engine.cluster.cacheType (deprecated) 81, 81
be.engine.cluster.cleanup 71
be.engine.cluster.EntityClassName.preload 73
be.engine.cluster.EntityClassName.preload.fetchsize 7

1
be.engine.cluster.EntityClassName.preload.preload 71
be.engine.cluster.externalClasses.classLoader 71
be.engine.cluster.externalClasses.path 72
be.engine.cluster.hasBackingStore 72
be.engine.cluster.isCacheAside 72
be.engine.cluster.isCacheLimited 71, 72
be.engine.cluster.isObjectCacheFullyLoaded 72
be.engine.cluster.minCacheServers 72
be.engine.cluster.multiEngineOn 72
be.engine.cluster.preload 73
be.engine.cluster.preload.fetchSize 73
be.engine.cluster.preload.handles 73
be.engine.cluster.recovery.distributed 73
be.engine.cluster.smtimeout.pollInterval 73
be.engine.cluster.smtimeout.refreshAhead 73
be.engine.coherence.useAutomatedRecovery 73
be.engine.externalClasses.packageExclusions 

(legacy) 73
be.engine.hotDeploy.enabled 73
be.engine.kernel.unifiedExtIdMap 73
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be.engine.limited.cache.back.size.limit 71, 71
be.engine.name 73
be.engine.om.berkeleydb.cacheweight.agent 73
be.engine.om.berkeleydb.dbenv 73
be.engine.om.berkeleydb.internalcachepercent 73
be.engine.om.eventcache.defaultmaxsize 73
be.engine.om.eventcache.maxsize.rule_session 74
be.engine.om.recovery.threads (not used) 81
be.engine.tangosol.oracle.prefetch 74
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be.ft.enabled (deprecated) 81
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be.http.docRoot 75
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be.oracle.dburi.pool.max.0 70
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be.trace.log.append 77
be.trace.log.dir (not used) 83
be.trace.publish.daemon (not used) 83
be.trace.publish.enable (not used) 83
be.trace.publish.network (not used) 83
be.trace.publish.service (not used) 83
be.trace.publish.subject (not used) 83
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enabling as cache provider 55
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customer support xix
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Enforce Pools 70
engine.cluster.isSeeder 41, 45, 54
Engine.FT.Groupname (deprecated) 83
Engine.FT.UseFT (deprecated) 83
Engine.FT.Weight (deprecated) 83
Engine.Log.MaxNum (not used) 83
Engine.Log.MaxSize (not used) 83
ENV_HOME xvi
Eviction Time 69
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functions documentation, accessing xv

H

heap size settings 29
HP-UX 33

configuring for 64-bit mode 32

I

importDesigner command line tool 59
importing a 3.x project at command line 59
importing a 3.x project in TIBCO BusinessEvents 
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Studio 58
importing a 4.x project at command line 46
Initial Size 69, 70
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on Windows 2000 Terminal Server 10
installation on UNIX

64-bit configuration 32
after installing, all UNIX Platforms 31
guidelines 11
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installation on Windows
installer account 10

installer
installer account (UNIX) 11
installer account (Windows 10

J
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L
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Linux
configuring for 64-bit mode 32

N

network drive, installing from (Windows) 10

R
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S

Solaris 10
configuring for 64-bit mode 32
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T

tangosol.coherence.cacheconfig 83
tangosol.coherence.distributed.backupcount 79
tangosol.coherence.distributed.localstorage 41, 45, 54, 

80
tangosol.coherence.distributed.threads 80
tangosol.coherence.localhost 80
tangosol.coherence.localport 80
tangosol.coherence.log 80
tangosol.coherence.log.level 80
tangosol.coherence.log.limit 80
tangosol.coherence.ttl 80
technical support xix
TIBCO BusinessEvents

uninstalling 17
upgrading 8

TIBCO Designer projects, importing at 
command-line 59

TIBCO Designer projects, importing in TIBCO Busi-
nessEvents Studio 58

TIBCO_HOME xvi

U

uninstalling BusinessEvents 17
UNIX

windowing environment for installation 11
upgrading BusinessEvents 8
 TIBCO BusinessEvents Installation



88 | Index
W

Windows 2000 Terminal Server, installing on 10
TIBCO BusinessEvents Installation


	TIBCO BusinessEvents® Installation
	Contents
	Preface
	Changes from the Previous Release of this Guide
	TIBCO BusinessEvents Express
	Related Documentation
	TIBCO BusinessEvents and Add-On Product Documentation
	Accessing TIBCO BusinessEvents Functions Reference Documentation
	Other TIBCO Product Documentation

	Typographical Conventions
	Connecting with TIBCO Resources
	How to Join TIBCOmmunity
	How to Access TIBCO Documentation
	How to Contact TIBCO Support


	Chapter 1 Installation Guidelines
	TIBCO BusinessEvents Components and Add-on Products
	TIBCO BusinessEvents Standard Edition Components
	TIBCO BusinessEvents Express Edition Components
	Add-on Products

	Installation Overview
	If Deploying with TIBCO Administrator, Install it First
	Using Oracle Coherence as Alternative Cache Provider
	Using OpenSSH for TIBCO BusinessEvents Monitoring and Management
	Required and Optional Products and Supported Platforms
	Installation History Log Files
	TIBCO Home and Default Installation Directory
	Using Multiple TIBCO Homes
	Using an Existing Eclipse (or TIBCO Business Studio™) Installation

	Upgrading TIBCO BusinessEvents
	Standard Upgrade Procedures


	Chapter 2 TIBCO BusinessEvents Installation
	Installation Guidelines
	Windows Installation Guidelines
	UNIX Installation Guidelines

	Installing TIBCO BusinessEvents
	Install in GUI Mode
	Install in Console Mode
	Install in Silent Mode

	Verifying the Installation
	Verifying TIBCO BusinessEvents Installation
	Verifying Add-On Product Installations

	Uninstalling TIBCO BusinessEvents
	Uninstall in GUI mode
	Uninstall in Console Mode

	Using an Existing Eclipse (or TIBCO Business Studio) Installation
	Configuring the Studio-tools Utility on Solaris x86
	Enabling the Generate Deployable Feature on Solaris

	Chapter 3 Post Installation Tasks
	Post Installation Tasks for All Platforms
	Migrating Projects
	Re-Initialize Studio Plug-ins Registry after Add-on Software Installation

	Check and Update JVM Settings in Properties Files
	All UNIX Installations — Directory Permissions
	Permissions for TIBCO BusinessEvents Directories

	Configuration for 64-bit Mode
	HP-UX


	Chapter 4 Migrating Projects from Earlier Versions
	Project Migration Overview
	Check Release Notes
	Migrating from Coherence to TIBCO BusinessEvents DataGrid Cache Provider
	Fixing Errors Due to Use of Words in Reserved Word List

	For Berkeley DB Object Management Users Only
	Migration from 5.0 to 5.1
	Migration from 5.0 to 5.1 for Add-on Products

	Migration from 4.x to 5.1
	Migrating 4.x Projects
	Importing a TIBCO BusinessEvents 4.x Project at the Command Line

	Migrating 3.x Projects
	Enabling Use of Oracle Coherence as the Cache Provider
	Understanding the CDD File (For 3.x Users)
	Most Runtime Properties are Configured in the CDD File
	Processing Units (Engines) and Agent Classes are Configured in the CDD File
	Metadata Properties (Extended Properties) are Configured in the CDD File

	Importing a 3.x TIBCO Designer Project
	Importing a 3.x Project into TIBCO BusinessEvents Studio
	Importing a TIBCO BusinessEvents 3.x Project at the Command Line

	Clean and Validate 3.x Projects
	Clean and Validate the Project
	Fixing Ambiguous Reference Errors (Unqualified References)
	Fixing XSLT Mapper Errors

	Oracle Types to JDBC Backing Store Migration
	Backing Store Data Migration Property Reference


	Chapter 5 Property Migration Reference
	Property Migration Reference

	Appendix A Deprecated and Unused Properties
	Index


